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About this guide 

This guide describes workflow, concepts and procedures for using the Infor Distribution FACTS 
Accounts Receivable module. 

Intended audience 
This guide is for FACTS end users, managers, in-house analysts, and trainers who require an 
understanding of the product and how to use it. 

Organization 
This table shows the chapters of the guide: 

Section Description 

About this guide Lists the intended audience as all users. 
Describe the purpose and the related 
documentation.  

Overview The overview section described the purpose of 
the Accounts Receivable application in terms 
of the business solutions that it provides, 
program listings, and menu trees, as 
applicable to the application.  

Work Flows & Program Concepts This section includes process flows for each 
module, program descriptions and concepts 
that are key to using this FACTS module. 

Transaction Procedures This section contains daily, weekly and end of 
year procedures as well as step-by-step 
processing information for entry, inquiry and 
transaction programs. 
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Related documents 
You can find the documents in the product documentation section of the Infor Support Portal, as 
described in "Contacting Infor" on page 8. 

Refer to the contents of the FACTS Version 9.3 & Incrementals folder located at 
https://support.infor.com/. Click Search>Browse Documentation>FACTS> Version 9.3 & 
Incrementals to view a document tree like this. 

o FACTS Version 9.3 & Incrementals
 Installation and Administration Guides

• Configuration Guides
• Demo Application Installation Guide
• Hardware Guide
• Installation Guide
• Online Help Installation Instructions
• Product Compatibility Matrix
• Technical Information

 Integrations
• Credit Card
• Document Management
• Infor Solutions

o eCommerce
o Storefront Integration Layer

• WMS
 Release Information

• Feature Demonstration Videos
• Program Menu Changes
• Release notes

o Incremental Release Notes
 User Guides

• Feature Implementation Guides
• Standard Module User Guides

Contacting Infor 
If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and 
create a support incident. 

The latest documentation is available from docs.infor.com or from the Infor Support Portal. To 
access documentation on the Infor Support Portal, select Search > Browse Documentation. We 
recommend that you check this portal periodically for updated documentation. 

If you have comments about Infor documentation, contact documentation@infor.com. 
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Chapter 1 Overview 

The Infor Distribution FACTS Accounts Receivable module maintains accurate file information, 
provides complete audit trails and optionally posts to General Ledger. Interaction with General 
Ledger is automatic and great flexibility is available through the use of GL posting tables. 

The system has been designed so that all transactions will produce a printed audit trail. This 
provides the secure feeling that all information is traceable throughout the system. Instructional 
prompts, default values and the capability to back up to previous prompts promotes both efficiency 
and comfort in using the system. 

Accounts Receivable is divided into these menus. 

Invoice Processing-create and manage individual customer invoices. 

Recurring Invoices-create and manage invoices for service contracts or maintenance 
agreements. 

Cash & Credit Application-post cash and checks received and make adjustments to open 
receivables. 

Returned Checks-manage returned customer checks. 

Dunning Letters-create past due notices and manage their distribution. 

Inquiries-quickly look up information about customers and AR invoices. 

Reports & Prints-track and manage Accounts Receivable information. 

End of Period-close out Accounts Receivable each period. 

File Maintenances-set up and maintain records for customers, salespeople, tax tables and 
customer payment history, and set controls for statement prints, dunning letters, etc. The 
system also contains an additional maintenances sub-menu; the programs are Infrequent 
File Maintenances. These infrequent file maintenances (found on the Infrequent File 
Maintenances menu) are used mostly during installation. 
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Posting AR to General Ledger 
Transactions from Accounts Receivable may automatically post to General Ledger. Through the GL 
Distribution flag set in the AR to GL Posting F/M, you determine how to post to GL for all AR 
transactions except sales (if at all). The flag may be set to one of the following: 0-indicating no GL 
distribution is printed or posted; 1-indicating the GL distribution is printed (printing is in detail format) 
but not posted to GL; 2-indicating the GL distribution is printed (printing is in detail format) and 
posted to GL in posted to GL in detail (posting includes each item contributing to the amount for 
each account number). 

Through the GL Posting Journal also set in the AR to GL Posting F/M, you determine which GL 
journal (where in the general ledger journal file) to post transactions from Accounts Receivable for all 
AR transactions except sales (if at all). 

The Accounts Receivable transactions that may print a GL distribution and post to GL are the 
transactions from the AR Sales Register, Cash Receipts & Adjustments Register, Returned Check 
Register and the Service Charge Register. 

The GL distributions are built and posted through the use of GL posting tables. 

Users establish their own set of valid GL posting tables. Each customer is assigned to a GL posting 
table that determines the correct GL account numbers to post to when posting a transaction to 
general ledger for that customer. The posting tables determine the general ledger distribution after 
the printing of various registers throughout the system. The following registers use the GL account 
numbers set up in the AR GL posting table(s): 

Cash Receipts & Adjustments Register distributes to accounts receivable G/L #, discount G/L # and 
adjustment G/L #.  

Service Charge Register distributes to service charges G/L #. 

Returned Check Register distributes to returned checks G/L #. 

AR Sales Register may distribute to Sales G/L #. 

SO Daily Sales Register may distribute to sales, misc. sales, inter-warehouse A/R, deposits, and 
accounts receivable G/L #s. 

Posting AR Sales to General Ledger 
The AR Sales to GL Posting F/M program sets up information that the system references when it 
automatically posts AR sales transactions to General Ledger. AR sales are posted to GL by the AR 
Sales Register. 

You set the GL distribution flag to one of the following: 0-indicating GL distribution is printed or 
posted; 1-indicating the GL distribution is printed (printing is in detail format) but not posted to GL; 2-
indicating the GL distribution is printed (printing is in detail format) and posted to GL in detail (posting 
includes each item contributing to the amount for each account number). 

In addition to the GL distribution, you set the GL posting journal flag to determine which GL journal 
(where in the general ledger journal file) to post transactions from Accounts Receivable for all AR 
transactions except sales (if at all). 
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There are standard entries made to general ledger when posting sales. For example, when 
something is sold, one debits the accounts receivable account and credits the sales account. You 
must set up where these standard GL account numbers used will come from, what they are and how 
they are to be used. 

The basis is asking where the number is to come from. The system either always uses the same 
account number or gives you choice as to where the number is pulled from (i.e., customer GL 
posting table). 

The department and branch flags have to do with imbedding the department and branch flags within 
the GL account number (if applicable). When entering an invoice, the department and branch may 
be entered. If you imbed the department and/or branch within the GL account number, the system 
looks at the department and/or branch assigned to each invoice. For example, if the G/L # to post is 
415-00-00 (department is fourth and fifth digits, branch is sixth and seventh digits), the department is
01 and the branch is 02, then the system posts to 415-01-02. The system inserts the department
and/or branch in the proper place within the GL account number.

This account type information is set up through the AR Sales to GL Posting F/M program. 

Accounts Receivable 

Basis - determines where the accounts receivable number comes from. You have a choice of always 
posting to the default accounts receivable G/L # (from this record) or posting to the accounts 
receivable G/L # assigned in the customer's GL posting table. The system may always post to one 
AR G/L # or break out accounts receivable to multiple account numbers (example: AR-retail, AR-
wholesale). 

Branch - determines if the system should insert the branch in the AR G/L #. The AR account may not 
be departmentalized. The SO and JC posting control records must have the same value for the 
branch flag as is entered here. 

Default GL account number - is used for posting purposes if the basis is set to D-default. If basis is 
set to C-customer GL posting table, the number is entered but not used for posting purposes. 

Sales 

Basis - determines where the sales number comes from. You have a choice of always posting to the 
default sales G/L # (from this record) or posting to the sales G/L # assigned in the customer's GL 
posting table. The system may always post to one sales G/L # or break out sales to multiple account 
numbers (example: sales-retail, sales-wholesale). 

Department and Branch - determine if the system should insert the department and branch in the 
sales G/L #. 

Default GL account number - is used for posting purposes if the basis is set to D-default. If basis is 
set to C-customer GL posting table, the number is entered but not used for posting purposes. 

Tax 

Basis - determines where the sales tax number comes from. You have a choice of always posting to 
the default sales tax G/L # (from this record) or posting to the sales tax G/L # assigned to each tax 
code in the Tax Tables F/M. The system may always post sales tax to one sales tax G/L # or break 
out sales tax to multiple account numbers (example: Georgia sales tax, Fulton County sales tax, City 
of Atlanta sales tax). 
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Department and Branch - determine if the system should insert the department and branch in the 
sales tax G/L #. 

Default GL account number - is used for posting purposes if the basis is set to D-default. If basis is 
set to T-tax code, the number is entered but not used for posting purposes. 

Freight, Contra COS (Cost of Sales), Cost of Sales 

Basis - determines where each account number comes from. The contra COS usually refers to 
Inventory. The numbers used always come from the default G/L # (from this record). 

Department and Branch - determine if the system should insert the department and branch in the GL 
account number. 

Default GL account number - is used for posting purposes because the basis is set to D-default. 
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Chapter 2 Work flow and program concepts 

Invoice processing 
The AR Invoicing system is a stand-alone invoicing system. There is no interaction with Inventory or 
Sales Orders. It may be used in addition to the Sales Orders system. Regardless of whether the AR 
Invoicing System will be used in normal processing, it will be utilized in entering opening balances 
during installation. 

Work flow 
Invoices are entered into the system through Invoice Entry where you assign invoice numbers. 
Invoices are printed (optional) through the Invoice Print program. The invoices are not updated into 
the open documents file until the Sales Register is run and updated. If an invoice is incorrect on the 
register, you can correct the invoice through the Invoice Entry and rerun the Sales Register. Invoices 
may then be reprinted through the Invoice Print program. When the Invoice Register is correct you 
can update it. 

Program concepts 
The AR Invoice Processing Menu contains these programs. 

Use the Invoice Entry (ARE110) program to create and correct customer invoices and credit memos 
in the Accounts Receivable system without using the Sales Orders or Inventory modules. The 
Invoice Entry screen consists of two sections. The upper portion of the screen is called the header, 
where you enter the customer, invoice date, etc. The lower portion is called the line-item entry 
section, where you enter items, pricing information, etc. At any time, you have the option of changing 
or deleting the invoice as well as adding and removing line items. Deleted invoices are not removed 
from the file. A deleted invoice’s line-item records are removed and the header record status is 
changed to deleted. The invoice appears on the next Sales Register as a deleted invoice and is 
removed in the register update. This procedure provides a complete audit trail of all invoice numbers 
used. 

You can print invoices in the Invoice Print program. Invoices may be corrected prior to the Sales 
Register update through the Invoice Entry program. Invoices will post to the open documents file 
during the optional update of the Sales Register. You have the option to: print an alignment check 
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(or a test check); print all invoice documents not yet printed; reprint selected invoice documents, and 
select the branch to print. Flags set in the Invoice Processing Control F/M determine whether or not 
invoices can be printed and on what type of form. After the system prints invoices, it updates and 
runs the Sales Register. 

Use the AR Sales Register (ARR110)to update system and customer balances. To ensure accuracy 
you can print and reprint the Sales Register without updating the system. You can choose to update 
when you are confident the invoices are correct. Use the AR Sales Register to: print an invoice 
register of all invoices; update invoices to the open receivables file, customer file, 
salesperson/territory file, sales tax file and GL journal file, and update the sales analysis holding file 
according to the sales information. 

Invoice Entry (ARE110) program 
A number of additional features are available in the Invoice Entry program. You can search for 
existing customers or add new customer records to the AR Customer File. You can enter invoice 
discounts, freight charges, GL departments, costing and pricing information and memos. Applicable 
taxes may also be computed and charged. 

Calculating commissions 
Use Company Control F/M to setup the proper prioritization of the contract price’s commission % 
and to set the commission flag for use highest/lowest/priority commission. As a line is being 
entered/edited in the Sales Order module, the default commission % values for customer, 
salesperson, item, and price are saved and used in commission calculation processing. 

Even though price data is not necessary for the AR Invoice Entry (ARE110) or AR Recurring Invoice 
Entry (ARE130) programs, the system reads the salesperson’s commission % and recalculates the 
invoice’s commission % each time the header is modified. 

Throughout FACTS, commission percentage processing is as follows when the price selected has a 
commission % assigned: 

There are five commission percent sources: customer, salesperson, item, price and current line 
commission. The system maintains a user override flag and a price type to designate if the user 
overrode the line’s commission during order entry. 

When calculating commissions, the system first checks the value of the Commission Flag. If the 
Commission Flag is set to H- always choose the Highest commission in the hierarchy, the system 
returns the highest commission %, excluding the line’s commission %, after replacing the item’s 
commission with the price’s commission if necessary. If the Commission flag is set to "L- always 
choose the Lowest commission in the hierarchy", it returns the lowest, non-blank, commission %, 
excluding the line’s commission %, after replacing the item’s commission with the price’s 
commission if necessary. 

If the value of the Commission Flag is set to X-calculate (always choose the commission that the 
hierarchy determines), the system checks the Commission Basis for the first priority to determine 
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which commission percentage to use. As the system navigates the priority string, it returns the first 
entry that has a commission other than "No Priority" (or blank) as the correct commission %. 

For example: If the commission hierarchy is set to SCIP the system would calculate the commission 
using the percentage assigned to the salesman who sold the merchandise. If no priority is assigned 
to the salesman, the second priority is checked. The system would then calculate the commission 
using the percentage assigned to the customer the merchandise was sold to. If no priority is 
assigned to the customer, the third priority is checked. The system would then calculate the 
commission using the percentage assigned to the item that was sold. 

If the price type is not a contract price, the position of the Price’s Commission % in the hierarchy will 
be ignored, and if a Price Commission is present, it will replace the Item’s Commission % 
(regardless of whether the Item’s Commission was "No Priority"). 

If the user override flag is set for the line-item during order entry processing, the system returns the 
Line’s Commission as the correct commission %. 

Customer credit check processing 
This program does all the calculations and gives the appropriate messages for customer credit 
check. This routine is called from various entry programs and only the results are returned. 

The system performs a customer credit check for each customer during Invoice Entry if the number 
of Credit Check Days entered on the Accounting tab of Customer F/M is less than 999. The Credit 
hold option for a customer is based on the Credit Check prompt on the Accounting view of Customer 
Maintenance. The current balance figure use for processing comes from the customer’s existing 
balance in AR Customer F/M. 

The password for the credit check override resides in the AR Static Control F/M. 

The credit check routine also checks the Disputed Invoice setting in AR Document Change F/M for 
each open AR document record. If it finds a disputed invoice record, the credit check processing 
checks the invoice’s Exclude from Credit Check setting in AR Document Change F/M to determine if 
the disputed invoice is to be considered in the credit check past due processing. Documents marked 
as excluded from credit checking are skipped from the total amount past due. All invoices total into 
the customer’s balance and aging figures. Any disputed invoices that are excluded from the credit 
check are accumulated into a new total. The check for over credit limit is calculated as the 
customer’s balance minus disputed invoices not to be included plus document totals. Then, if the 
customer is past due, the excluded total displays on the optional Customer Aging window that 
displays in AR Invoice Entry and Sales Orders Entry programs: Quote Entry, Sales Order Entry, 
Direct Invoice Entry, Counter Sale Entry, Credit Memo Entry, Customer Returns Entry, and Blanket 
Sales Order Release Register and Post Recurring Documents. 

Customer aging window 
Customer aging information includes the customer name and number, credit limit, aging as of date, 
balances for aging columns set in AR Aging Control F/M, balance, aging open documents totals, 
amount excluded from credit check processing and a "Disputed Invoices’ indicator (based on the 
Disputed Invoice setting in AR Document Change F/M. 
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AR Sales Register (ARR110) 
Use the AR Sales Register to update system and customer balances. To ensure accuracy you can 
print and reprint the Sales Register without updating the system. You can choose to update when 
you are confident the invoices are correct. Invoice register information includes the following: 

Summary - invoice number, invoice date, terms code, salesperson/territory, department, customer 
number and name, merchandise amount, discount amount, cost amount, tax amount, freight 
amount, and total amount of invoice. 

Detail - summary information plus line number, item, description, taxable flag, cost and price for 
each item on the invoice. 

During the AR Sales Register update, FACTS updates the bank transaction system only for invoices 
with cash type terms codes (C,1-4) that have the cash GL# set to "BANK". Any non-cash terms 
codes or cash terms codes that are set up with a specific cash GL number will update GL and will 
not update the bank balance or transfer over to the bank reconciliation system. 

Cash terms codes are indicated by a $ to the right of the terms code. Customers over their credit 
limit are indicated by an asterisk (*) to the right of the invoice total. Subtotals are printed for cash and 
for Accounts Receivable. The register totals include the total number of invoices on the register and 
their average invoice amount. All deleted (deleted before printing) and voided (deleted after printing) 
documents appear on the register to provide a complete audit trail of all invoice numbers. Depending 
on the setting for the flag in the AR sales posting to GL record, you can obtain a general ledger 
distribution printout. 

Recurring invoice entry subsystem 
As with regular invoicing, you enter the customer number and item number, etc. on all recurring 
invoices. You can also make changes to the invoices in the Recurring Invoice Entry (ARE130) 
program. You can set up standard monthly invoices such as rental agreements or periodic entries 
such as service or maintenance contracts. This relieves the burden of the entry each period. The 
program may also be used to change header or line-item information for existing documents. The 
Recurring Invoice Entry screen consists of two sections. The upper portion of the screen is called the 
header portion where the customer number, salesperson, etc. is entered. The lower portion is called 
the line-item portion where each item, price, etc. is entered. The system reads the salesperson’s 
commission % and recalculates the invoice’s commission % each time the header information is 
modified. Refer to the Calculating Commissions topic for processing details. 

A list of recurring invoices may be printed at any time through the Recurring Invoice Listing. The 
program lets you designate which type of recurring invoices (expired, unexpired, etc.) to output. This 
list can help you verify proper entry, project future expiration, project a specific period's posting and 
verify proper amounts for the current period. Report information includes: customer number and 
name, sequence number, ship-to number, salesperson/territory, terms code, tax code, posting day, 
months to post, standard posting amount, cutoff, number, amount of posting to date, the reference 
number, status and number of invoices listed. 
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The invoice will be posted to the invoice entry file when the Post Recurring Invoices program is run. 
It will then be treated like any other invoice in the invoice entry system and will be posted to the open 
documents file when the Sales Register is run. This program does not post recurring invoices into 
the open documents file, but rather into the sales entry file where an audit trail is traced. Posting 
through day 31 will close out the current month for recurring invoicing. As documents are created, 
the customer’s and the salesperson’s commission percentages are reread and the document’s 
commission % recalculated. Refer to the Calculating Commissions topic for processing details. After 
posting the recurring invoices, the customer's balance and open documents are updated along with 
the General Ledger in the update following the Sales Register print. o GL record, you can obtain a 
general ledger distribution printout. 

Cash and Credit application 
Use the Cash & Credit Application sub module to post cash and checks that you receive and make 
adjustments to Open Receivables. Use this sub module to post payments, discounts and/or 
adjustments to customer invoices; create on-account balances, apply credit memos or on-account 
balances to customer invoices; and post miscellaneous cash paid by a customer or no specific 
customer. 

By using batch amounts and distributed amounts, you can make sure the system distributes all 
money correctly. 

Work flow 
Use the Cash Receipts & Adjustments Entry program to post payments, discounts and adjustments 
to customer accounts and miscellaneous cash to GL accounts. This program may be used each time 
cash and checks are to be deposited into the bank and to process customer payments by credit 
card. The Cash Receipts & Adjustment Entry (ARE210) program also allows the import of an 
external payment file into the FACTS system for AR Lockbox and ACH transactions. It may also be 
used to adjust customer invoice balances or apply credit memos against invoices. Customer 
balances and document balances are not changed until the Cash Receipts & Adjustments Register 
is printed and updated. In Cash Receipts and Adjustment Entry, no two users may pay the same 
document at the same moment. The program gives you the option to skip the document or retry. 
When a document has already been paid on an existing batch, other batches that access the 
document may only pay off the balance of the document. 

The postings are not updated to the open receivables file until the Cash Receipts & Adjustment 
Register is run and updated. If a check was entered incorrectly, you can choose not to update the 
register and go back into the entry program to make corrections. When the Cash Receipts & 
Adjustment Register is correct, you can update it. 

Use the Document Change F/M change dates on invoices running the register. Use this program to 
change the following information about a document in the open documents file: Current discount 
,Ship-to number, Entry date, Due date, Discount due date, Entry period and Memo These fields may 
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be changed without affecting the amount of the document. In order to make amount changes to the 
document, you must use the Cash Receipts & Adjustments Entry program and Register. 

Use the Automatic Credit Application Register to run through the open receivables file and print a list 
showing each customer with credit memos and listing invoices that the credit memos will apply 
against, by document number, beginning with the oldest invoice on file, or by due date. The optional 
update applies the credit memos to the invoices in the open receivables file. This program 
automatically reads through each customer’s invoices and if there are any credit memos and on-
accounts, they are applied (beginning with the oldest invoice) to the invoices with due dates that fall 
before the cutoff date. If the program encounters customer invoices that are marked as ‘disputed 
invoices’ in AR Document Change F/M, it does not include those invoices for processing. The 
register is printed displaying how the credit memos and on-accounts will be applied. Nothing is 
updated until you update the register after printing. Register information includes the following: 
customer number, name, document number, entry date, old balance, amount applied, credit applied 
and new balance. Customer and report totals are also included. 

Program concepts 

Cash Receipts & Adjustments Entry (ARE210) 
The Cash Receipts & Adjustments Entry screen is divided into two sections: the header portion 
where you enter the batch number and batch amount and the line item portion where you add all 
checks and miscellaneous cash transactions within the batch. 

Once you complete the batch information, you can enter checks and miscellaneous cash 
transactions within the batch in customer#/check# order in the line browser. If you entered or edited 
the check information, the system displays the Apply Payment Entry (ARE211) screen, which is 
used to distribute a check to the open Accounts Receivable documents that it is to pay. If you 
entered or edited the miscellaneous cash information, the system displays the Miscellaneous Cash 
Entry (ARE212) screen, which is used to distribute a miscellaneous cash transaction to the proper 
GL accounts. 

For disputed documents, the system displays a Y in the D column of the invoice listing. You can post 
payments against disputed documents, but the Auto Apply function bypasses disputed invoices. 

This program also allows entry and processing of customer payments by credit card. Once 
processed, the credit card payment cannot be deleted. If necessary, it can be voided which will 
process a void on that card number. A payment entered for credit card must be processed through 
the credit card processor before the batch will post on the Cash Receipts and Adjustments Register. 

AR Lockbox and ACH Transactions-You can import an external payment file into the FACTS 
system. The program interprets the incoming data by using a payment map and creates PVX Import 
Payment and Remittance files of this information. 

When you create a new cash receipts batch you can indicate that this is an electronic batch by using 
the Electronic Batch button beside the Batch field (or via the menu option for accessing this same 



Work flow and program concepts 

Infor Distribution FACTS Accounts Receivable User Guide  | 19 

feature). Selecting this button displays the New Electronic Batch (ARE210) program so you can 
enter batch information. 

You can open an existing electronic batch just like any other batch by typing in the batch number in 
the batch field or using the Search button. If the selected electronic batch had not yet been imported 
into a cash receipts batch, FACTS displays the Batch Correction Entry (ARE210) screen, where you 
can enter all information needed for a cash receipts check that is not obtainable from the external 
payment file. All required information must be entered in Batch Correction Entry (ARE210) before 
the payments can be imported into a cash receipts batch. Once all check information is correct, the 
payment batch will be converted into a cash receipts batch and display in Cash Receipts & 
Adjustment Entry (ARE210). 

After the imported lines from the external payment file are reviewed and corrected as needed in 
Batch Correction Entry (ARE210), FACTS returns you to the Cash Receipts & Adjustment Entry 
(ARE210) program. The Batch Total is automatically calculated from all of the check amounts 
imported and cannot be changed. If the map indicates that there is a batch summary record and the 
number of checks and total amount from this record does not match the calculated number of 
checks and batch total, FACTS displays a message indicating this. 

Cash Receipts and Adjustment Entry for electronic batches can also process miscellaneous cash 
payments as well as customer account payments. When a line is highlighted in Batch Correction 
Entry, click Misc Cash to assign the customer number with Miscellaneous Cash. Any remittance 
advice will be ignored when importing. Once the batch is imported into Cash Receipts Entry, you can 
apply the account number to this payment for proper GL handling. 

Once in the cash receipts files, the only check header field that can be changed is the memo. All 
other fields will be disabled. The Type field will be set based on the map setting. 

The program indicates if any checks are not fully distributed; click Apply to resolve these. 

In an electronic batch, the only checks can be from the import file and must be processed together, 
so you cannot add or delete lines to electronic batches. 

You can delete the entire batch. Upon deleting an entire electronic batch, a message is displayed, 
indicating that the electronic data was not imported and the external payment file will be restored 
from the encrypted archive file. All records for this batch will be removed from the PVX Import Files 
and the standard cash receipts files. 

If you have already imported the batch records into the AR Cash Receipts Batch and later determine 
that one check is actually a payment for multiple customers or a check is to the wrong customer, you 
can use the menu option to allow that payment record to be sent back to the Batch Correction Entry 
program. If the payment had been applied, you must delete all the apply transactions before this 
option will be allowed. Once back in Batch Correction Entry, the customer number can be changed 
or the payment split. You have the options to save the payment in the correction screen or bring it 
back into the Cash Receipts Entry screen. If the payment is saved in Batch Correction Entry, FACTS 
re-displays Batch Correction Entry program when you enter the batch number again in Cash 
Receipts & Adjustment Entry. You must correct and re-import the payment back into Cash Receipts 
Entry before the remainder of the batch can be accessed. 
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Cash Receipts & Adjustment Register (ARR210) 
This register should be printed, checked and updated following each Cash Receipts & Adjustment 
Entry. Most users do this on a daily basis per deposit. 

Processing details 
The Cash Receipts & Adjustment Register debits the cash account of the bank for each transaction 
running through the register. If the bank designated on the register uses the deposit system, the 
Cash Receipts & Adjustment Register debits the new cash clearing account of the bank for each 
check instead. The Cash Receipts & Adjustment Register creates records in the indirect transaction 
files instead. There is one header record created in the SMITRH file for a register run and then each 
check transaction will create a record in the line file (SMITRL). If the bank does not use the deposit 
system or is set to auto create the deposit, the indirect transactions are used to create a deposit 
transaction in the new bank transaction files (SMTRNH/SMTRNL). The only exception to this is if the 
bank uses the deposit system and is set to auto create the deposit but the total of all the checks 
(deposit amount) is less than or equal to zero. In this case, the deposit is not created. 

You do not have to exit the Cash Receipts & Adjustment Entry program to print and/or update 
batches. As long as a batch is not in use by another user, it can be run through the register. 
However, the system updates only fully distributed batches. 

When you select to run all batches through the Cash Receipts Register, the system checks the 
batches and any that are in use or out of balance cause the message "The following batches are out 
of balance or in use and will be skipped XXX" to be displayed when you click OK. Then, when the 
register prints, these batches are not printed. 

If a credit card payment or credit is entered but not processed, the batch will not run through the 
update. These will be added to the message that you receive if “all” batches is selected. 

Register information for each entry includes the following: batch number, customer number and 
name, check number, date applied, document number, original document amount, entry date, 
current document amount, due date, discount amount, and discount due date. Transaction 
information includes payment amount, discount amount, adjustment amount, adjustment code, new 
document balance, check amount and memo. Depending on a flag in the company AR static control 
record, you can obtain a general ledger distribution. The report also includes information on batch 
total, report total and total number of checks for both batch and report. 

Debit memo transactions are reported along with the other transactions that are applied to a check. 
The information shows the payment amount as a negative of the amount that was entered. This 
indicates that the debit memo actually reduces the payments amount. The totals on the debit memo 
amount print in the summary portion at the bottom to reflect the new AR balance and the deposit 
total. 

Templates that store "current period" (or similar values like "system date") resolve to the "current 
period at the time the report is run" rather than what the "current period" was at the time the template 
was created. For example: If you save a template for the Cash Receipts & Adjustments Register and 
select "System Date" for the Date field, when that template is selected to run again (either manually 
or via Job Stream) the current date is determined using the FACTS system date when the register is 
run not the date when the template was created. 
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Recap information includes this information. 

Beginning AR balance Payments 

- Payments + On-accounts created 

- Discounts - On-accounts applied 

+ Adjustments - Credit memos applied 

+ Debit memos created - Debit memos created 

- On-accounts created Cash applied to AR 

+ On-accounts applied + Customer misc. cash 

+ On-accounts applied + Misc. cash 

If the Deposit ticket flag is set to Y in the cash receipts control record, a deposit ticket will print after 
the Cash Receipts Register. The deposit ticket prints the following: batch number, bank, account 
number, check number, customer name, and check amount. The deposit total and total number of 
checks and batches listed are also included. 

If the payment is by credit card, the last 4 digits of the credit card number will print next to the type. If 
the payment is voided, the receipt number of the void will print. 

Electronic Batch Processing-When you access the Cash Receipts & Adjustment Register (ARR210) 
screen from the menu, FACTS displays a warning message identifying any electronic batches that 
are not complete, meaning that the batch still remains in the correction entry screen or the batch or 
checks are not fully distributed. 

If you select to run the register for a single electronic batch, the bank code defaults to the bank code 
entered when the batch was created. If you change the bank code on this screen, FACTS displays a 
message warning that the bank indicated during the batch creating was different. This will not, 
however, prevent you from running the register and posting to a different bank. 

If you select to run the register for all batches, any electronic batches that do not match the bank 
code selected for the register will not process. 

Once a batch is updated, FACTS removes all records for that batch from the PVX Import payment 
and remittance Files. 

Deposit Ticket Archiving-In FACTS, you can view the Deposit Ticket printed at AR Cash Receipts 
& Adjustment Register through any Archived Register button in AR for a Cash Receipts & 
Adjustment Register - each register that produces a Deposit Ticket has a link to that corresponding 
Archived Deposit Ticket (in the same fashion each register is linked to its GL distribution). 

The Deposit Ticket archived in AR at the time of the AR Cash Receipts & Adjustment Register 
update is not printable/viewable from FACTS when in the SM Banking module. The AR Deposit 
Ticket and the SM Banking Deposit Ticket are not linked/related. 

You can view the SM Banking Deposit Ticket, once one is printed/archived, from FACTS from 3 
different locations. These options will be disabled for lines which have not had a Deposit Ticket 
printed/archived. If UnForm Document Archiving is not used then these options will not be present. 
The shortcut character key in all cases is the letter "h". 
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The Bank Reconciliation, Bank Inquiry, and Bank Transaction Listing programs allow you to view the 
deposit ticket using the Menu option "View" - "Archived Deposit Ticket", or using the button 
"Archived Dep", or right-click on the line that has a Deposit Ticket number and select "Archived 
Deposit Ticket". 

Returned checks 
This sub module enables you to handle returned customer checks in an efficient manner. 

The Returned Checks menu includes the following programs: 

The Returned Check Entry program, which is used to enter returned checks into FACTS. 

The Returned Check Register, which is used to print a register of all returned checks. 

Work flow 
There are two ways to enter a returned check into the system: 

• As a first-time return, which produces an audit trail through the register but does not update
the customer’s open account.

• As a second- time return, which produces an audit trail and places a document for the check
amount and returned check charge back into the customer’s open account.

To enter and update returned check into the system: 

1 Create a record of a returned check in the Returned Check Entry program. 

2 Run the Returned Check Register to review all the returned checks enters. Running the register 
simply outputs a list of returned checks so that you can verify accuracy. If you enter a check 
incorrectly, you can choose not to update the register so you can return to the entry program and 
make corrections. The register does not update the Open Documents file with returned checks 
until you tell it to do so. 

3 When you are ready, run the optional update in the Returned Check Register and this will update 
the system. 

Dunning letters 
The Dunning Letters menu contains programs that enable you to build a complete past due notice 
system.  

The dunning letter parameters should have been set up in the Dunning Letter Control F/M during 
installation. 
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Specify up to five standard dunning letters through the Dunning Letter Text F/M program. Each letter 
should include the salutation and closing if used.  

Each customer record contains a flag that determines if that customer is eligible for dunning letters 
and the number of the last dunning letter sent. You can process dunning letters may at any time. 
When you do, print the Dunning Letter Edit List to verify which customers will receive them and 
which number letter they are to receive during the next dunning letter batch print.  

The Dunning Letter Edit List contains an optional update, in which you can automatically set the Last 
Dunning Letter Sent flag back to zero in a customer’s file if that customer did not print on the 
Dunning Letter Edit List. The system then prints dunning letters through the Dunning Letter Print 
program based on the information on the edit list. Dunning letters may be printed on blank paper or 
on a preprinted form. At the end of the Dunning Letter Print program, there is an optional update that 
may update the last dunning letter sent flag in the customer’s file to that of the dunning letter just 
printed. 

Inquiries 
Use inquiries to display information on customers on the screen without affecting any data in any 
files and without locking any files.  

The Customer Inquiry displays various information about a customer and includes a search by 
contact. The information included is general, code, aging, open documents, detail documents, sales 
history, payment history, ship-tos, notes, sales orders, paid documents, ledgercards, and equipment. 
You can also enter notes through this program.  

The Document Inquiry displays detail documents including all transactions. 

Reports and prints 
All Accounts Receivable reports give you the option of printing in customer number, alphabetic, 
salesperson/territory or customer class order. In addition to the order, you may choose the range to 
print. For example, if the order chosen is customer number, the beginning and ending customer 
number is asked for. 

Program concepts 
Each report in Accounts Receivable is described in this section. 

The Open Receivables Report prints a list of open documents, zero balance documents or both. The 
options are to print in summary (customer and their balance), detail (customer and information on 
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each invoice for the customer), or detail with transactions (customer and invoice and all transactions 
against that invoice). Branches may also be selected. 

The Aged Trial Balance prints a report of all open documents in aging columns as of a specified 
aging date. (Aging columns are determined by the user.) The report may be printed in summary 
(customer and balance), detail (customer and information on each invoice due by the customer), and 
detail with transactions (customer and invoice and all transactions against that invoice). Branches 
may also be selected. 

The Sales History Report prints various sales history and/or gross margin information from the 
customer’s history. The user may select MTD, YTD and/or PYR information and determine a 
minimum to print. Branches may also be selected. 

The Salesperson/Territory Sales Report prints various sales history and/or gross margin information 
from the salesperson/territory’s history. The user may select MTD, YTD and/or PYR information and 
determine a minimum to print. Branches may also be selected. 

The Payment History Report prints various payment history information from the customers’ 
payment history in three accumulation periods. Branches may also be selected. 

The Inactive Customer Listing prints a list of all customers who have been inactive as of a date that 
you specify. Sales history figures may be included in the report. This report will not update any files 
but may be useful in allowing you to delete inactive customers. Branches may also be selected. 

The Customer Listing prints a report of general information, code information or sales information on 
the customers. The customer’s address, phone number, contact information and/or message may 
print on either report. In addition to the standard sort order choice, you may select a beginning and 
ending code to print (terms code, tax code, GL posting tables, geography code, statement code). 
Branches may also be selected. 

The Customer Ledgercards Report prints a list of the transaction types chosen which have affected 
the customer’s balance. Branches may also be selected. 

The Customer Label Print program prints up to 99 labels per customer and may be sorted by zip 
code. The user may choose to print for active or inactive customers and branches may also be 
selected. 

The Rolodex Customer Card Print program prints up to 99 cards per customer and may be sorted 
alphabetically. The user may choose to print for active or inactive customers and branches may also 
be selected. 

The Ship-To Report prints customers and all their different ship-to addresses. (The billing address is 
not included.) Temporary ship-to’s may be printed and branches may also be selected. 

The Customer Standard Order Listing (ARR765) prints a report of customer standard orders, 
including ship-to information. Information in this report is originally entered through the Standard 
Order Entry (SOE250) program. 

Information in this report is originally entered through the Standard Order Entry program. 

The Ship-To Label Print program prints up to 99 labels per ship-to selected by the customer. 
Customer or contacts may be included. 

The Customer Balancing Register is only run when the customer’s balance does not agree with the 
open invoices for that customer (i.e., very unlikely - if there was a power failure in the middle of an 



Work flow and program concepts 

Infor Distribution FACTS Accounts Receivable User Guide  | 25 

update, etc.). The register prints all out-of-balance customers. The optional update will correct each 
customer’s balance and the total AR balance. 

The Customer Notes Print program prints the notes for any customers in the customer notes file. 
Branches may be selected. 

The Check Payment History Report program prints accounts receivable document information by 
check number for the specified customers.  

The AR Code List prints a list of the various AR codes including customer classes, salespeople, 
regions, terms codes, tax codes, GL posting tables, adjustment codes, and customer price classes. 

End of period 
The AR End of Period Menu contains these programs. 

The Service Charge Register (optional) will calculate service charges and post them to customer 
accounts. The Service Charge Register is a recommended part of the end-of-period procedures. 
Use it to generate and print service charges based on the information in the service charge control 
record. The register’s optional update posts the service charges to the customer accounts in the 
open documents file. The system then creates and assigns SC and four digits to the document 
(example SC0079). 

The Statement Print (optional) program will print statements for selected customers. You can print 
statements for any group of customers by using statement codes, which are assigned to each 
customer in the Customer F/M program. The Statement Print program requires field of statement 
codes to print. Only customers with the chosen statement codes will have a statement printed. 
Although statements may be printed at any time, it is recommended that you print them at the end of 
each period as part of the end-of-period procedures. 

The Sales Tax Register gives a list of each tax code including each invoice with the sales tax 
generated by that tax code. Options set in the Sales Tax Control F/M affect how this register prints. 
An optional update allows the user to remove the records printed on the register. The SO Daily 
Sales Register, the JC Invoice Register, the AR Sales Register, the ER Daily Rental Register and 
the Invoice Register post information to the sales tax file. It is suggested the report be printed and 
updated as part of the end-of-period procedures. To prevent file overflow, the records should be 
removed on a regular basis 

The Register History Report gives you a list of all registers run which updated the accounts 
receivable balance for the period. This provides a trace of what transpired to obtain the current AR 
balance. The optional update removes the records just printed through the current period without 
affecting any balance. Registers that appear on this report include the SO Daily Sales Register, JC 
Invoice Register, ER Daily Rental Register, Invoice Register, AR Sales Register, Cash Receipts & 
Adjustments Register, Returned Check Register, and Service Charge Register. It is suggested the 
report be printed as part of the end-of-period procedures. To prevent file overflow, the records 
should be removed on a regular basis. 

The Document Removal Register gives you a list of all zero balance documents (open receivables 
paid down to zero). All of the registers listed contain optional updates that should be run to clear the 
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files to start a new period. The update also maintains the customer payment history file and writes 
documents removed to the paid documents file if set to do so in AR Static Control FM. Prior to 
running this register, invoices are updated through the SO Daily Sales Register, JC Invoice Register 
or AR Sales Register and paid off in full and updated in the Cash Receipts & Adjustments Register. 
The update portion of this program writes information to the payment history file. Information is 
available to print on the Payment History Report. The update portion also writes open documents 
and their associated transactions to the paid documents and paid documents transactions file. Paid 
document information is then available for display in the Customer Inquiry - Paid Documents view. If 
there are any cash receipts batches that have not been updated, the system displays the message 
"Cash Receipts batches have not been posted. Some documents may not be removed.", and the 
program continues on without removing any AROPEN documents in a cash receipts batch that has 
not been updated. It is suggested that this report be printed and updated as part of the end-of-period 
procedures. To prevent file overflow, the records should be removed on a regular basis. 

The Customer Ledgercard Removal program removes ledgercards by customer, 
salesperson/territory or customer class. The program can be run in customer, alpha, 
salesperson/territory or customer class order based on a transaction cutoff date. This program is a 
recommended part of the end-of-period procedures. 

The End-of-Period Update will close the current accounts receivable period by rolling period-to-date 
figures to zero and incrementing the current period by one. The End-of-Period Update should be run 
at the end of each Accounts Receivable period. Note: The End of Period Update cannot be run if 
there are any cash receipts batches that have not been updated. The program read through the 
possible cash receipts batch files to see if any batches are unposted and displays a message if all 
batches are not posted and returns to the main FACTS menu. This update enables you to: Close out 
the current period in accounts receivable. clear the period-to-date customer and 
salesperson/territory sales information; roll year-to-date information to the prior year, if this is the end 
of the year; roll payments history down one period, dropping the oldest period and remove paid 
document history based on the number of periods stored. Before you run this update, make sure the 
following has already been printed and updated: Service Charge Register, Statement Print, Sales 
Tax Register, Register History Report, Document Removal Register, and Customer Ledgercard 
Removal. 

Service Charge Register (ARR810) Processing 
The Service Charge register can automatically update the General Ledger. To activate this feature, 
make sure the GL Distribution control in the AR to GL Posting F/M is set to 2 (summary) or 3 (detail). 
You can also set the GL distribution control to 1 so that FACTS prints the GL distribution without 
updating the General Ledger. Set it to 0 if you don’t want it to print or update to the GL distribution at 
all. 

The register uses the AR GL posting tables to build the GL distribution. 

Templates that store "current period" (or similar values like "system date") resolve to the "current 
period at the time the report is run" rather than what the "current period" was at the time the template 
was created. For example: If you save a template for the Service Charge Register and select 
"System Date" for the Service Charge Date field, when that template is selected to run again (either 
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manually or via Job Stream) the current date is determined using the FACTS system date when the 
register is run not the date when the template was created. 

Report information includes the following: customer number and name, and number of grace days 
allowed before charging service charges for that customer. 

Summary: For each customer, the total number of documents past due, the total original amount and 
current amount of all past due documents, and the total service charge. 

Detail: All open documents for each customer. Printed information consists of document number and 
type (IN-invoice, CM-credit memo, OA-on-account, SC-service charge, RC-returned check) entry 
date, due date, number of days past due, original and current amounts and the service charge. 

On both the detail and summary version, the report includes a register total of all current amounts 
and service charges and the total number of customers listed is also included. An asterisk (*) beside 
the service charge indicates the charge is below the minimum and will not be charged. 

File maintenances 
Each file maintenance program in Accounts Receivable is described in this section. 

Customer F/M (ARF910) is used to create and maintain records in the customer file. Each record 
contains a customer number and general information relevant to the customer. This file is the 
backbone of the Accounts Receivable System and is referenced by virtually all programs in the 
Accounts Receivable and Sales Orders Systems. Customer numbers may be automatically assigned 
by the system. Before entering customers, you must set up at least one customer class, customer 
price class, GL posting table, salesperson/territory, tax code, and terms code. You can manage 
standard orders for existing customers with a ship-to of Same. Customers with open SO or AR 
documents, payment history and ship-to’s may not be deleted. Also, customers may not be deleted 
in this program if they are defined in any other files in the system. If you use Counter Sales in Sales 
Orders, set up at least one cash customer for all Counter Sale cash customers. In addition, create at 
least one false customer to be used to transfer sales history to when deleting a customer from the 
customer file. The system automatically prompts you for the customer number to transfer to and 
transfers sales history to that false customer number in sales analysis. 

Ship-To F/M (ARF920) is used to enter an unlimited number of ship-to addresses for each customer. 
You can enter an unlimited number of ship-to addresses for each customer. Note: If a customer’s 
ship-to address is the same as the customer address, you don’t have to set up a record in this 
program. The customer must be set up in Customer F/M before you can create ship-to records. 
Each ship-to record contains a customer number, ship-to number and general information relevant to 
the ship-to number. You can manage standard orders for existing customer/ship-to combinations. 

Payment History F/M (ARF930) is used to create and maintain the payment history file so the 
system can gather past payment history on some or all customers. These records are used to print 
the Payment History Report and to display payment history in the Customer Inquiry. Records will not 
be stored here unless the Payment History flag in the Customer F/M is set to selected. It must be set 
up in the Payment History Control F/M as to the type of payment history being stored before records 
may be entered here. 
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Salesperson/Territory F/M (ARF935) is used to create and maintain information on each salesperson 
and their territory. You can establish your own set of valid salesperson/territory codes and their 
descriptions along with region and commission percentage. The SO Daily Sales Register and AR 
Sales Register will update the month-to-date and year-to-date sales and cost information. Before 
you can create salesperson/territories, you must set up at least one region in Region F/M (located on 
the AR Infrequent File Maintenance menu). In addition, set up at least one false salesperson/territory 
code to which the system can transfer sales history if you need to delete a salesperson/territory 
record. 

Use Corporate Group Entry (ARE995) to create and maintain corporate groups and assign 
customers to the groups. The customers can be assigned individually using the line entry or auto-
assigned by salesperson/territory. A customer can belong to more than one corporate group. 
Whenever a new corporate group is created or the name is changed, the system adds a record to 
the SMCATL log file for the next update to the eStorefront database. This is for the CorporateGroup 
request. A record is also be added when a corporate group is deleted. This is for the 
CorporateGroupDelete request. 

The Default Tax Code Entry (ARE990) program is designed for two purposes: 1) to help the 
distributor manage which customers get which tax code; and 2) to allow the B2C order in eStorefront 
(where we only know the ship-to address) to be properly taxed. (B2C functionality will be available in 
the GA Release of the eStorefront integration to FACTS). To that end, this program allows the 
distributor to setup each State, and first indicate whether or not they should charge tax for orders 
delivered in that state. Typically, if a distributor has a business presence in a state, they must charge 
tax on orders delivered to that state. The defaults setup in Default Tax Code Entry will not override 
actual tax codes entered in Customer F/M, Ship-To F/M, or Temporary Ship-To Entry in Order Entry. 
But each of those programs has visibility of what the default is. In order to facilitate rapid setup of the 
Default Tax Code data, there is a menu option "Tools/Populate". Selecting this option will read 
through the existing data in Customer F/M and Ship-To F/M and establish the defaults from the 
known Tax Codes. During the Populate function, customers and ship-tos that are tax exempt will be 
skipped, so the defaults are only populated with tax codes from customers and ship-tos that are 
actually charged tax. Also provided are additional menu options, "Tools/Customer Conflicts" and 
"Tools/Ship-To Conflicts" to help the distributor identify existing Tax Codes in Customer F/M and 
Ship-to F/M that do not match the defaults. The user will be able to go directly to Customer F/M or 
Ship-To F/M in order to make any necessary changes. Conflicts do not have to be resolved, and 
may in fact be appropriate. This is simply a tool to help the distributor analyze their tax codes and 
how they are assigned to customers and ship-tos. 

Tax Table F/M (ARF940) is used to create and maintain the tax code file. You establish your 
company’s own set of valid tax codes to be assigned to each customer. The tax code determines tax 
applied during invoicing. You must enter the required tax code, NOTAX. 

Tax Reporting F/M (ARF945) is used to maintain sales tax reporting information in the sales tax file. 
This file is used to print the Sales Tax Register. Records are updated to this file during the Daily 
Sales Register update and are removed during the update portion of the Sales Tax Register. 
Information is provided automatically from the Daily Sales Register. This program should only be 
used to correct the merchandise amount, taxable amount, entry date and total tax if there is a 
discrepancy. 

Transfer/Change Customer Codes (ARU910) is used to change specific information in the customer 
file for a range of customers. These fields are all part of the information stored on each customer in 
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the customer file. This program is especially useful for making changes to many customers without 
having to manually change each customer individually through the Customer F/M program. 

Two examples for the use of this program are: 

• If you decide to start storing payment history for a range of customers who previously did not
have payment history stored.

• If you decide to change the terms code for a range of customers.

All fields being changed must be valid fields. For example, if changing customer classes, all classes 
being changed to must be valid customer classes. Changes made in this program do not affect 
transaction files or other modules. 

Transfer/Change Ship To Codes (ARU920) is used to change specific information in the customer 
file for a range of customer ship-to addresses. These fields are all part of the information stored on 
each ship-to location in the customer file. This program is especially useful for making changes to 
many customers without having to manually change each ship-to location individually through the 
Ship-To F/M program. 

Two examples for the use of this program are: 

• If you decide to modify the ship complete designation or the way to handle committing stock
for sales orders for a range of ship-to locations.

• If you decide to change the UPS Zone for a range of ship-to locations.

All fields being changed must be valid fields. For example, if changing tax codes, all tax codes being 
changed to must be valid tax codes. Changes made in this program do not affect transaction files or 
other modules. 

CC Token Management (SME958) is available on the AR file maintenances menu for users with 
proper authorization set on the Security tab of User Code F/M (SMF410). You can manage credit 
card tokens for use with CenPOS credit card processing. Credit card tokens can be created for the 
specified customer or by ship-to location for the customer. To access this screen, the CC Token 
Management prompt in Customer Defaults F/M (ARF840) must be set to Customer or Ship-to and 
CenPOS must be selected as the credit card processor. Refer to Infor Distribution FACTS Electronic 
Payments Guide for CenPOS for details. 

Infrequent file maintenances 
Region F/M (ARF950) is used to create/maintain region codes. Region codes are used in the 
Salesperson/Territory F/M program to assign territories to salespeople. These codes are also used 
in selected Sales Analysis reports to sort information. You can establish your own set of regions and 
descriptions. If your company doesn’t assign salespeople to territories, create one region code, 
name it ALL REGIONS and assign all salespeople to that region. 

Customer Class F/M (ARF952) is used to enter/maintain customer class codes, such as retail, 
wholesale, in state, out of state, etc. These codes can be assigned to each customer and can be 
used in most AR report to help sort or filter customer information. Customer Classes can also help 
you set up a more detailed accounting system. You can create AR GL tables based on customer 
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classes to track sales according to each class. If you choose not to use customer classes, then 
create one class and assign it to all customers in Customer F/M. 

Customer Price Class F/M (ARF953) is used to enter/maintain customer price class records. The 
program allows you to create and maintain customer price class records. Each new customer must 
be assigned a customer price class in the AR Customer F/M. These classes are user-defined. 
Customer price classes are used for setting up contract pricing in sales orders. For example, you 
can set up contract prices for a customer price class indicating that each customer assigned to that 
price class is eligible for that contract price. If you choose not to use customer price classes, then 
one class must be entered and all customers are assigned to that class. 

Terms Code F/M (ARF954) is used to enter/maintain the terms code file. You establish your 
company’s own set of valid terms codes to be assigned to each customer as a default value in sales 
order entry and AR invoice programs. The terms codes are used to determine due date, discount 
date and terms discount during the update portion of the SO Daily Sales Register, AR Sales 
Register and JC Invoice Register. 

GL Posting Table F/M (ARF956) is used to set up GL posting tables for different customer types, so 
that transactions can be posted and tracked with greater detail. For example, if you wanted to post 
services charges applied to retail customers to a different account than service charges applied to 
wholesale customers. To achieve that result, you would create a GL posting table for retail 
customers and another for wholesale customers in this file maintenance, each containing a different 
GL account number for service charges. Then in the AR to GL Posting Table, you would change the 
service charges basis flag to C-Customer. When the Service Charge Register is run, service 
charges will post to their respective accounts. 

Customer Defaults F/M (ARF840) is used to set up default information when adding prospects or 
customers. The fields defined here will be used as the default entries when adding prospects or 
customers. These fields can be changed when entering new prospects or customers. Only one 
record can be set up in this program; the system automatically supplies it a customer number of 
NEW.  

Register History F/M (ARF958) is used to trace through all registers of the current period to see how 
the accounts receivable balance is affected by each register. When initially setting up the AR 
system, no records need to be entered here. The Register History Report provides a printout of 
these records, maintaining a complete audit trail of the AR balance. For every register printed and 
updated that affects the accounts receivable balance, a record is created by the system. Information 
includes the AR Register Trace Number: As a register is updated the system assigns a trace number 
to it and Register Type. Register Types are: Cash receipts, Returned checks, JC invoicing, Service 
charges, Invoicing, Daily sales, Bad debts, Auto credit apply, K-customer balancing, Equipment 
rental invoicing, and Technical support invoicing. 

Adjustment Code F/M (ARF960) is used to enter/maintain adjustment code records. You establish 
your own set of valid adjustment codes and their descriptions for use in the Cash Receipts & 
Adjustment Entry program. Valid adjustment codes must be set up here prior to entering 
adjustments in the Cash Receipts & Adjustments Entry program. Each adjustment code has an 
assigned GL account number. In the AR to GL Posting F/M, the Adjustments GL Post flag 
determines whether adjustments post to GL based on the customer type (pulled from the AR GL 
posting table) or based on the adjustment type (pulled from the adjustment code). If the flag is set to 
A-adjustment, then the GL number assigned to the code is posted when entering an adjustment in
the Cash Receipts & Adjustment Entry program.
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Aging Control F/M (ARF962) is used to enter/maintain aging information used to print the Aged Trial 
Balance and statement forms. The information in this file is used to determine column headings, 
aging breaks, and the correct columns for open receivables. 

Cash Receipts Control F/M (ARF964) is used to set controls for posting cash in the Cash Receipts & 
Adjustments Entry program. You can specify: whether credit memos and on-accounts are on the 
document list, whether to print a deposit ticket after the Cash Receipts Register, the last cash check 
number, and the last on-account document used. 

Electronic Payment Mapping (ARF966) is used to maintain electronic map files used to map files for 
importing external payments in the Cash Receipts & Adjustment Entry program. This program allows 
you to define the type of external payment file and as necessary allows you to define map the fields 
used and their size, and the directory location of the external files. 

Statement Print Control F/M (ARF968) is used to set printing parameters for AR statements. You 
can specify: preprinted form or stock paper, whether or not a tear-off return portion is used on the 
statement, whether zero-balance documents are printed and number of message lines used. This 
record must be entered prior to entering statement messages and printing statements. 

Statement Messages F/M (ARF970) is used to create and maintain statement messages. You 
establish the messages to be printed on the statements depending on the aging information on each 
statement. The maximum number of lines entered in a message is determined in the Statement Print 
Control F/M. Therefore, prior to entering messages, the statement print control record must be set 
up. 

These messages appear on the Statement Print program. The message that prints on each 
statement is determined by the oldest document on that statement. For example, assume you have 
five aging columns on your statement and the oldest document is in column 3. The message for 
break number 3 is printed. 

Payment History Control F/M (ARF972) is used to create and maintain the payment history control 
record. This control record must be set up prior to entering payment history for customers or running 
the Document Removal Register. Payment history is updated by the zero balance documents (paid 
off) removed by the Document Removal Register. 

Returned Check Control F/M (ARF974) is used to create and maintain the returned check control 
record.  

Service Charge Control F/M (ARF976) is used to create and maintain the service charge control 
record. Establish service charge information to be used for each customer in the case of late 
payment. This control record must be set up prior to running the Sales Tax Register.  

Sales Tax Control F/M (ARF978) is used to create and maintain the sales tax control record. This 
control record must be set up prior to running the Sales Tax Register to establish certain sales tax 
information that pertains to the Sales Tax Register.  

Dunning Letter Control F/M (ARF980) is used to create and maintain the dunning letter control 
record. This control record must be set up prior to running the Dunning Letter Text F/M, the Dunning 
Letter Edit List and the Dunning Letter Print.  

Invoice Processing Control F/M (ARF982) is used to create and maintain the invoice processing 
control record. Establish the format for the Invoice Entry program including: Last invoice used, 
Invoice memo, and Length of invoice. AR invoice processing is often used to enter open balances 
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just prior to first time processing. For loading balances, initially all flags should be set to N. Just prior 
to live processing, after all open balances have been updated to AR (i.e., Sales Register updated), if 
AR Invoicing is to be used, you can reset the flags to fit your needs. 

AR to GL Posting F/M (ARF984) is used to create and maintain the AR sales (AR Sales Register 
only) posting to GL control record. This record contains information such as journal and account 
numbers, which the system references when it posts AR Sales Register data to the GL in the AR 
Sales Register Update. All GL numbers entered must be valid GL numbers. You set up the GL 
distribution, i.e., how the distribution is to post into the journal file in GL (example: print only, print 
and post). In addition to the GL distribution, set up where in the journal file in GL the distribution is to 
post, i.e., the sales journal. 

Static Control F/M (ARF988) is used to create settings and controls that are critical to how the AR 
system functions. 

Nonstatic Control F/M (ARF990) is used to display information that the AR system references and 
updates as performs various functions. 

CAUTION! We strongly advise administrators to password-protect the Static Control F/M (ARF988) 
and Nonstatic Control F/M (ARF990) programs. Changes should be made only with extreme caution 
and under the supervision of your local FACTS office. 
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Chapter 3 Transaction procedures 

Recommended operating procedures 
Recommended operating procedures consist of daily, weekly and end of period procedures to use 
the Accounts Receivable module.  Transaction procedures are available for step-by-step 
instructions.   

* indicates the procedure is required and must be performed in the time period designated

Daily procedures (or as needed) 
1 Post cash receipts and adjustments.  

2 Print/update Cash Receipts & Adjustments Register.  

3 Enter returned checks, print/update Returned Check Register.  

4 Enter invoices, print/update Sales Register. 

Weekly procedures (or as needed) 
1 Print dunning letters. 

Period procedures (or as needed) 
1 Complete all invoicing.  

2 Complete all cash posting.  

3 Print/update Service Charge Register. 

4 Print Open Receivables Report. 

5 Print Aged Trial Balance. 

6 Run Customer Ledgercard print. 
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7 Print statements.  

8 Print/update Sales Tax Register.  

9 *Print/update Register History Report.  

10 *Print/update Document Removal Register. 

11 Run System Clean Up F/M (SMF993). 

12 *Run End-of-Period Update. 

Yearly Procedures 
*1 Run End-of-Period Update. (already covered in period procedures - do NOT run twice)

Invoice procedures 
The AR Invoicing system is a stand-alone invoicing system. There is no interaction with Inventory or 
Sales Orders. It may be used in addition to the Sales Orders system. Regardless of whether the AR 
Invoicing System will be used in normal processing, it will be utilized in entering opening balances 
during installation. 

Entering AR invoices 
1 Click Accounts Receivable>Invoice Processing>Invoice Entry. 

2 Specify the invoice number (1-999999) or press Enter to assign the next number on file. 

3 Specify customer. 
The system displays the customer number, price level (if price levels are used), name and 
address, salesperson/territory, terms code, branch and department (if used). At the bottom of the 
screen, the customer's balance, credit limit, last sale date, phone number, contact and message 
are displayed. The system performs the credit check on the customer. 

4 Specify this header information. 

(Optional) ship-to number Press F4 to modify the ship-to address. Press F3 to enter a 
temporary ship-to name and address for this invoice. Press S to display the Show Address 
window to view header address information for the customer. 

invoice date 

salesperson/territory code 

payment terms code 

branch 
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GL department number 

(Optional) Specify the customer reference number. The information is required if the PO 
required flag in the customer file is set to Y. 

5 Specify the item information. 

item number  

item description 

item cost  

If the item number is used as the quantity, include the cost of all the items in this line number. If 
this field is not available, ensure the Enter cost flag in the Invoice Processing Control F/M is set 
to Y. 

item price  

If the item number is used as the quantity, include the price of all items in the particular line 
number. 

6 (Optional) At the Charge Tax field, specify Y or N to determine whether tax should be charged 
on the line-item. Press Enter to default to Y. 

7 (Optional) Add additional items as needed. 

8 Click End to display the Footer. 

9 Specify the footer information. 

(Optional) memo 

(Optional) discount 

(Optional) freight amount 

(Optional) tax code (If tax is charged) 

10 At the Print invoice now? message, indicate whether to print the invoice now. 

11 Click End. 

12 Click End again to exit. 

Printing and updating the Sales Register 
1 Click Accounts Receivable>Invoice Processing>Sales Register. 

2 Specify the sales register date.  

3 Specify the branch number to print.  

4 Specify the scope of the information that should print. The choices are Summary and Detail 
information. The program defaults to S-Summary. 

5 Click OK. 
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The system builds the GL distribution while it prints the Sales Register. The parameters 
established in the AR Sales to GL Posting F/M program and AR GL posting tables affect how the 
system builds the distribution. 

6 Check register. OK to print GL distribution? After printing the Sales Register, verify the printout. If 
you need to make a correction, click Cancel to exit the program. You can rerun the register after 
you make the correction. If everything is correct, click OK to continue. The program prints the GL 
distribution. Verify the accuracy of the GL distribution, and when you are ready, proceed with the 
update. 

OR 

If you are not printing the GL distribution, the system displays this message: Check register. OK 
to update? 

7 After printing the Sales Register, verify the printout. If there is a correction to be made, click 
Cancel to exit the program. After the correction is made, the register can be rerun. If everything 
is correct, click OK to continue. The program will not print a GL distribution, it skips the following 
field and proceeds with the update. 

8 Check GL distribution. OK to update? After printing the distribution, verify the printout. If 
everything is correct, click OK to continue. The program proceeds with the update. If there is a 
correction to be made, click Cancel to exit the program. After the correction is made, the entire 
register process begins again. The program runs the register first, then prints the GL distribution, 
and then updates if you tell it to do so. 

Recurring invoices procedures 
Use these procedures to send any recurring invoices, such as service contracts or maintenance 
agreements. Recurring Invoice Entry allows you to create the invoice one time so that FACTS can 
automatically post it to the receivables system for each month you designate. It also allows you to 
set up a cutoff so the monthly invoicing stops at a predetermined time. 

Entering recurring invoices 
1 Click Accounts Receivable>Invoice Processing>Recurring Invoices>Recurring Invoice 

Entry. 

2 Specify the customer number. 

3 The system displays the customer number, price level (if price levels are used), name and 
address, salesperson/territory, terms code, branch and department (if used). At the bottom of the 
screen, the customer's balance, credit limit, last sale date, phone number, contact and message 
are displayed. The system performs the credit check on the customer. 

4 Specify the header information: 

sequence number (00-99) 
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ship-to number 

post day, which is the day the invoice should post to the invoice entry file (01-31). 

cutoff type to use to stop generating the invoice: Date, Number of invoices, or Amount. 

cutoff 

salesperson/territory code 

payment terms code 

branch 

GL department number 

(Optional) customer reference number  

The information is required if the PO required flag in the customer file is set to Y. 

5 Specify the item information. 

item number 

item description 

item cost 

Note: If the item number is used as the quantity, include the cost of all the items in this line 
number. If this field is not available, ensure the Enter cost flag in the Invoice Processing Control 
F/M is set to Y. 

item price If the item number is used as the quantity, include the price of all items in the 
particular line number. 

6 (Optional) At the Charge Tax prompt, specify Y or N to determine whether tax should be 
charged on the line-item. Press Enter to default to Y. 

7 (Optional) Add additional items as needed. 

8 Click End Entries. 

9 Click End to display the AR Invoice Footer. 

10 Specify the footer information: 

(Optional) memo 

(Optional) discount 

(Optional) freight amount 

(Optional) tax code (If tax is charged.) 

11 Click End. 

12 Click End again to exit. 
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Cash and credit application procedures 
Use the Cash & Credit Application procedures to post cash and checks that you receive and make 
adjustments to Open Receivables. You can post payments, discounts and/or adjustments to 
customer invoices; create on-account balances, apply credit memos or on-account balances to 
customer invoices; and post miscellaneous cash paid by a customer or no specific customer. 

Entering new batches for cash receipts and adjustments 
1 Click Accounts Receivable>Cash & Credit Application>Cash Receipts & Adjustments 

Entry. 

2 Complete steps 2-8 to enter the cash receipt/adjustment header information  

3 Specify the Batch. For existing batches, all checks and miscellaneous cash transactions already 
applied to this batch are displayed in the browser in the lower portion of the screen.  

4 Specify the total amount of the batch (0-99999999.99) in the Batch Total field.  

5 The Distributed field displays the amount of all the checks and miscellaneous cash transactions 
that have been entered for the batch (for new batches, this is 0). The Balance field displays the 
batch total minus the distributed amount (for new batches this the batch total). 

6 Specify the customer number. Entry of a valid customer number displays the customer name, 
balance, credit limit, phone, contact and memo. (For existing batches, press Add to access the 
Customer field.)  Refer to the Customer Search topic for details about searching for customers.  

-OR- 

Press F3 to enter miscellaneous cash instead of the customer number.  

-OR- 

Press F1 to enter the invoice number if you do not know or remember the customer number. The 
default information will remain by customer number but the system displays the Invoice # prompt 
so you can enter the invoice number 

7 Specify the check number (up to six characters). Press F3-Cash to assign a cash number from 
Cash Receipts Control F/M to identify this entry if posting cash.    

8 Specify the check date.  

9 Specify the check or cash amount to be posted for this customer (+/-9999999.99). 

10 (Optional) Specify any memo to identify or explain this transaction (up to 30 characters). The 
memo prints on the Cash Receipts & Adjustments Register. 

11 Click Save. 

12 If you entered or edited the check information, the system displays the Apply Check Entry 
(ARE211) screen, which is used to distribute a check to the open Accounts Receivable 
documents that it is to pay.  
-OR- 
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If you entered or edited the miscellaneous cash information, the system displays the 
Miscellaneous Cash Entry (ARE212) screen, which is used to distribute a miscellaneous cash 
transaction to the proper GL accounts. 

Adding a line to a batch for cash receipts and adjustments 
1 Click Accounts Receivable>Cash & Credit Application>Cash Receipts & Adjustments 

Entry.  

2 Specify the batch number (up to four alphanumeric characters) in the Batch field. The total 
amount of the batch (0-99999999.99) displays in the Batch Total field.  

3 Click Add; complete this information. 

Specify the customer number. Entry of a valid customer number displays the customer name, 
balance, credit limit, phone, contact and memo. (For existing batches, click Add to access the 
Customer field.) Refer to the Customer Search topic for details about searching for customers. 

-OR- 

Press F3 to enter miscellaneous cash instead of the customer number.  

-OR- 

Press F1 to enter the invoice number if you do not know or remember the customer number. The 
default information will remain by customer number but the system displays the Invoice # prompt 
so you can enter the invoice number 

5 Specify the check number (up to six characters). Press F3-Cash to assign a cash number from 
Cash Receipts Control F/M to identify this entry if posting cash.  

6 Specify the check date.  

7 Specify the payment type for the transaction. You can select from: C-Cash, 1-Check, 2-Credit 
Card, 3-Debit Card, 4-EFT. 

8 Specify the check or cash amount to be posted for this customer (+/-9999999.99).  

9 (Optional) Specify any memo to identify or explain this transaction (up to 30 characters). The 
memo prints on the Cash Receipts & Adjustments Register. 

10 Click Save. 

11 If you entered or edited the check information, the system displays the Apply Check Entry 
(ARE211) screen, which is used to distribute a check to the open Accounts Receivable 
documents that it is to pay. 

-OR- 

If you entered or edited the miscellaneous cash information, the system displays the 
Miscellaneous Cash Entry (ARE212) screen, which is used to distribute a miscellaneous cash 
transaction to the proper GL accounts. 
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Entering cash receipts and adjustments 
1 Click Accounts Receivable>Cash & Credit Application>Cash Receipts & Adjustments 

Entry. 

2 Specify the batch number (up to four alphanumeric characters) in the Batch field. For existing 
batches, checks and miscellaneous cash transactions already applied to this batch are displayed 
in the browser in the lower portion of the screen.   

3 Specify the total amount of the batch (0-99999999.99) in the Batch Total field. You can enter a 
new batch total or access the Add to batch screen, where you can enter the amount to add to 
the batch total. 

4 In the Distributed field, the system displays the amount of all the checks and miscellaneous 
cash transactions that have been entered for the batch. In the Balance field, the system displays 
the batch total minus the distributed amount.  

5 (Optional) Click Add to add a line to the batch. 

-OR- 

Highlight an open document in the lower portion the screen and select from the following: 

C to access Note Entry (SME710) for the customer specified in the program.  

List Pmts to access List Payments (ARE214), which lists all of the invoices, miscellaneous cash 
and on-accounts made with the currently displayed check. Information listed includes invoice 
number, GL number (for misc. cash only), GL description (for misc. cash only) or memo (for debit 
memos only), payment amount, discount amount, and adjustment amount and adjustment code. 

Apply to apply the payment by automatically accessing either the Apply Payment Entry 
(ARE211) or Miscellaneous Cash Entry (ARE212) payment program as appropriate.  

Done to complete entry of the check by updating the distributed amount of the batch, clearing 
the screen and returning to the Batch field. The system allows you to exit the batch entry without 
entering any checks or miscellaneous cash transactions. If the batch is not fully distributed, you 
will receive a message but will be allowed to exit the entry. Your changes update the batch 
control record, batch amount distributed, and batch fully distributed system setting. 

6 (Optional) For existing checks or miscellaneous cash entries, highlight an open document in the 
lower portion the screen and delete the check or miscellaneous cash entry or edit the memo, 
date or amount for the check or miscellaneous cash entry and click Save. 

7 Click Done to complete entry of the batch by updating the distributed amount of the batch, 
clearing the screen and returning to the Batch field. The system allows you to exit the batch 
entry without entering any checks or miscellaneous cash transactions. If the batch is not fully 
distributed, a message is displayed. Your changes update the batch control record, batch 
amount distributed, and batch fully distributed system setting. 
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Entering and applying payments 
1 FACTS displays Apply Payment Entry (ARE211) immediately after you add or edit a payment on 

the Cash Receipts and Adjustments Entry line entry. You can also access this program by 
clicking Apply on the Cash Receipts and Adjustments Entry screen when a check transaction is 
highlighted. 

2 Use the Doc Type, Sort By, and Apply fields to select the open Accounts Receivable 
documents to display in the line item browser so you can distribute the check. 

The system displays this information from Cash Receipts and Adjustments Entry: customer 
number, name, date, amount, payment type and memo. 

3 (Optional) Update the payment type for the transaction: C-Cash, 1-Check, 2-Credit Card, 3-
Debit Card, A-ACH.  

4 (Optional) Update the amount and memo.  

5 The system maintains and displays the following:  

Check Amount--The remaining check amount as payments are applied. 

Distributed Amount--The distributed amount as payments are applied. 

Balance--The batch balance as payments are applied. 

OA Total--The total amount of all on account transactions created on this check.  

Miscellaneous Cash Total--The total amount of all miscellaneous cash transactions created on 
this check. 

Debit Memo Total--The total amount of all debit memo transactions created on this check. 

(Optional) If the distributed balance is less than the amount of the check, click Remainder on 
Account to create an OA transaction for that amount. Then specify the branch. 

If an OA has already been created, click Remainder on Account to update it with the new 
amount. Click Clear On Account Amount to delete the OA that was previously created in the 
cash receipts file. 

6 Highlight an open Accounts Receivable document. You have these options. 

Delete – delete or zero out the payment, discount and adjustment dollars that have been 
applied to the highlighted invoice.  

Edit – modify the line level fields: Payment, Discount and Adjustment and Adjustment Code 
and apply monies from the check to the individual documents.  

Notes-access Note Entry (SME710) for the AR document highlighted in the line item browser.  

Pay - pay the default amounts up to the remaining balance that is undistributed, even replacing 
an existing payment amount. The payment amount will increase the distributed amount for the 
check.  

Pay/Edit - sets the default amounts and allows you to modify the line level fields: Payment, 
Discount and Adjustment and Adjustment Code. Click Save. The payment amount will 
increase the distributed amount for the check. 
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Debit Memo - access Debit Memo Entry (ARE213) to create debits back to the customer’s 
account that are not related to any existing invoice. The total debit memo amount decreases the 
distributed amount for the check. 

Auto Apply - acts against the documents currently loaded in the line browser. The system 
displays the Auto Apply window. Specify the Start At point in the browser window to start the 
auto apply. Options are top, bottom and highlighted. Specify the Order (which direction the 
auto apply will go from the starting point). Options are up and down. Click OK. The Auto Apply 
process starts. The system highlights the first line to be processed and applies a payment and 
discount using the same rules as in the current program. The system updates the line browser 
with the new payment information. Then, depending how you selected to run the Auto Apply, the 
next line to be processed is highlighted. If a document is in use when the auto apply is updating, 
the system allows you to select to retry the document, skip the document or cancel the 
remainder of the auto apply. 

7 You can select from these options. 

List Selected Displays the List Selected for Check screen containing the customer number and 
name along with a grid prompt to enter the desired document numbers. If a list was already 
selected during this session, those documents automatically fill the grid field.  

Header Displays the Header Detail screen, which allows you to change the filter and order fields, 
date, amount and memo. Use this screen to change more than one of the filter fields to avoid the 
browser reloading with each change.  

Done Completes the process. If the check is not fully distributed, the system displays a message 
and then allows you to exit.  

8 Click Done to complete entry of the check by updating the distributed amount of the batch, 
clearing the screen and returning to the Batch field.  

9 Click Done to exit.  

Managing debit memos (not tied to invoices) 
1 FACTS displays Debit Memo Entry (ARE213) when you click the Debit Memo in Apply Check 

Entry (ARE211). 

This information is displayed from Cash Receipts and Adjustments Entry (ARE210): customer 
number, name, check number and check date. You cannot modify this information.  

The miscellaneous cash amount and the memo are also displayed. You can modify this 
information. 

2 The system maintains and displays the check amount, the distributed amount, the undistributed 
check balance as payments are applied and. the total amount of all debit memo transactions 
created on this check. The line browser displays any existing debit memos for this check 
distribution.  

3 For new debit memos click Add, or to modify an existing debit memo, highlight it and click Edit.  
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4 Specify the amount to expense. The system displays the remaining undistributed balance as 
the default. (Only positive amounts are allowed.)  

5 (Optional) Specify the memo. 

6 Specify the branch. The system displays the last branch entered from either debit memo entry 
or OA entry as the default. The system skips this field if your system is not set to use branches in 
the GL number and there is a branch record set up to default to. The system uses the branch 
entered here in the GL Distribution when setting the GL AR Account # 

7 Click Save. 

8 You have these options. 

Add another debit memo. Then specify the amount, branch and memo. Click Save. 

Delete a debit memo. Highlight the line in the browser and click Delete.  

Edit debit memo information. Highlight the line in the browser and click Edit. Specify the 
amount, branch and memo for the transaction. Click Save. 

9 Click Cancel to stop line entry. 

10 Click Done. When you exit this program, the total of the debit memos entered decrease the 
distributed amount of the check. 

11 (Optional) Click List Pmts to display List Payments (ARE214), which lists all of the invoices, 
debit memos, miscellaneous cash and on-accounts made with the currently displayed check. 
Information listed includes invoice or debit memo number, payment, discount, and adjustment 
amount. 

12 When you have completed the debit memo entry, click Done to display Apply Check Entry 
(ARE211) where you can apply the distribution.  

Entering and applying Miscellaneous Cash 
1 FACTS displays the program immediately after you add or edit a miscellaneous cash entry on 

the Cash Receipts and Adjustments Entry line entry. You can also access this program by 
selecting the Apply option on the Cash Receipts and Adjustments Entry screen with a 
miscellaneous cash transaction highlighted. 

2 The customer number and name, check date, miscellaneous cash amount and memo display 
from the check information from the Cash Receipts and Adjustments Entry program. You can 
modify this information. 

3 The system maintains and displays the remaining cash amount, the distributed amount, and the 
batch balance as payments are applied. The line browser displays all GL accounts that the 
miscellaneous cash transaction is distributed to.  

4 For new miscellaneous cash transactions, click Add.  

5 Specify the GL number(s) to expense. 
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6 Specify the amount to expense. The system displays the remaining undistributed balance as the 
default. (Zero and negative amounts are allowed.) 

7 Click Save. You can continue to add more miscellaneous cash GL accounts numbers and 
distribution amounts. 

8 Click Cancel to complete line entry. 

9 (Optional) You have the following options for lines in the browser: 

Add a new GL account. Specify the GL account number. Specify the amount to be distributed 
to this account number. Click Save. 

Delete – To delete a GL account distribution, highlight the line in the browser and click Delete. 
To delete an entire miscellaneous cash transaction, all lines (GL numbers and amounts) must be 
deleted and the check distributed amount updated. 

Edit the GL account numbers and amounts of a miscellaneous cash transaction. Highlight the 
line in the browser and click Edit. 

10 Click Done. The system returns you to the Cash Receipts & Adjustments Entry (ARE210) 
program where you can apply the distribution or enter more cash receipts and adjustments:  

Running the Cash Receipts Register 
1 Click Accounts Receivable>Cash & Credit Application>Cash Receipts & Adjustments 

Register. 

2 Specify the batch number to print. If the batch number entered or if one of ALL batches are not 
in balance (i.e., distributed does not equal deposits), the optional update is not available. 

3 Specify the deposit date.  

4 Specify the deposit number (0-9999). You have to option to use part of the number on the 
deposit slip, the date, or any other number to identify this deposit. (This is a memo field.)  

5 Specify the bank ID code.  

6 Specify Y or N to indicate whether this is the correct date and GL period for the Sales Register to 
post. 

7 The system builds the GL distribution while it prints the Cash Receipts Register. The parameters 
established in the AR Sales to GL Posting F/M program and AR GL posting tables affect how the 
system builds the distribution. 

8 Check register. OK to print GL distribution? displays. After printing the Cash Receipts Register, 
verify the printout. If you need to make a correction, enter N to exit the program. You can rerun 
the register after you make the correction. If everything is correct, enter YES to continue. The 
program prints the GL distribution. Verify the accuracy of the GL distribution, and when you are 
ready, proceed with the update. 

OR 
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For users not printing the GL distribution but printing the deposit ticket, the following field is 
displayed: 

Check register. OK to print deposit ticket?  

After printing the Cash Receipts Register, verify the printout. If there is a correction to be made, 
enter N to exit the program. After the correction is made, the register can be rerun. If everything 
is correct, enter YES to continue. The program then prints the deposit ticket.  

For users not printing the GL distribution or the deposit ticket, the following field is displayed: 

Check register. OK to update?  

After printing the Cash Receipts Register, verify the printout. If there is a correction to be made, 
enter N to exit the program. After the correction is made, the register can be rerun. If everything 
is correct, enter YES to continue and no further printing takes place, the following fields are 
skipped and the program proceeds with the update. 

For users printing the GL distribution and the deposit ticket, the following field is displayed: 

Check GL distribution. OK to print deposit ticket?  

After printing the GL distribution, verify the printout. If there is a correction to be made, enter N to 
exit the program. After the correction is made, the entire register process begins again. If 
everything is correct, enter YES to continue. The program then prints the deposit ticket.  

For users printing the GL distribution but not printing the deposit ticket, the following field is 
displayed: 

Check GL distribution. OK to update?  

After printing the GL distribution, verify the printout. If there is a correction to be made, enter N to 
exit the program. After the correction is made, the entire register process begins again. If 
everything is correct, enter YES to continue and no further printing takes place, the following 
field is skipped and the program proceeds with the update. 

For users printing the deposit ticket, the following field is displayed: 

Check deposit ticket. OK to update?  

After printing the deposit ticket, verify the printout. If there is a correction to be made, enter N to 
exit the program. After the correction is made, the entire register process begins again. If 
everything is correct enter YES to continue to proceed with the update. 

Running an Automatic Credit Application Register  
1 Click Accounts Receivable>Cash & Credit Application>Automatic Credit Application 

Register. 

2 Specify the order in which to run the register. Options are customer (default), alpha, 
salesperson/territory or customer class.  

3 Specify the beginning order choice.  

4 Specify the ending order choice. 
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5 Specify the sort order to apply: D - Document Number or U - Due Date.  

6 Specify the cutoff date or the last due date to update.  

7 Specify the transaction date to use when applying credit.  

8 Indicate whether this is the correct date and GL period for the Automatic Credit Application 
Register to post. 

9 The system builds the GL distribution while it prints the Sales Register. The parameters 
established in the AR Sales to GL Posting F/M program and AR GL posting tables affect how the 
system builds the distribution. 

The message Check register. OK to print GL distribution? is displayed.  

After printing the Automatic Credit Application Register, verify the printout. If you need to make a 
correction, click Cancel to exit the program. You can rerun the register after you make the 
correction.  

If everything is correct, click OK to continue. The program prints the GL distribution. Verify the 
accuracy of the GL distribution, and when you are ready, proceed with the update. 

OR 

If you are not printing the GL distribution, the system displays this message: Check register. OK 
to update? 

After printing the Automatic Credit Application Register, verify the printout. If you need to make a 
correction, click Cancel to exit the program. You can rerun the register after you make the 
correction.  If everything is correct, click OK to continue. The program will not print a GL 
distribution; it skips the following field and proceeds with the update. 

Check GL distribution. OK to update? After printing the distribution, verify the printout. If 
everything is correct, click OK to continue. The program proceeds with the update. If there is a 
correction to be made, click Cancel to exit the program. After the correction is made, the entire 
register process begins again. The program runs the register first, then prints the GL distribution, 
and then updates if you tell it to do so. 

Returned checks procedures  

Entering a returned check 
1 Click Accounts Receivable>Returned Checks>Returned Checks Entry. 

2 Specify the bank code.   

3 Indicate whether the check is being returned for the 1-first or 2-second time. 

4 Specify the customer number, the number of the returned check (up to 6 characters), the 
date the check was written (check date) and the date the check was returned (return date). 
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5 Specify the check amount (.01-9999999.99).  

6 Specify the amount of the check charge (.01- 99.99).  

7 Specify the branch number.    

8 (Optional) Specify the memo that you want to appear on the Returned Check Register (up to 40 
characters). 

9 Click Save.  

10 Click Exit. 

Printing and updating the Returned Check Register 
1 Click Accounts Receivable> Returned Checks>Returned Checks Register. 

2 Specify the deposit date into the bank. 

3 Specify the deposit number (0-9999). 

4 Specify the bank ID code.  

5 Click OK. 

The system builds the GL distribution while it prints the Returned Check Register. The 
parameters established in the AR Sales to GL Posting F/M program and AR GL posting tables 
affect how the system builds the distribution. 

When the system completes the register, it displays the message: End of Report. Click OK to 
continue.  

6 Check register. OK to print GL distribution? displays. After printing the Returned Check Register, 
verify the printout. If you need to make a correction, click Cancel to exit the program. You can 
rerun the register after you make the correction. If everything is correct, click OK to continue. 
The program prints the GL distribution. Verify the accuracy of the GL distribution, and when you 
are ready, proceed with the update. 

When the system completes the distribution, it displays the message: Distribution complete. 
Click OK to continue. 

OR 

If you are not printing the GL distribution, the system displays this message: Check register. OK 
to update? 

After printing the Returned Check Register, verify the printout. If there is a correction to be made, 
click Cancel to exit the program. After the correction is made, the register can be rerun. If 
everything is correct, click OK to continue. The program will not print a GL distribution, it skips 
the following field and proceeds with the update. 

7 Check GL distribution. OK to update? After printing the distribution, verify the printout. If 
everything is correct, click OK to continue. The program proceeds with the update. If there is a 
correction to be made, click Cancel to exit the program. After the correction is made, the entire 
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register process begins again. The program runs the register first, then prints the GL distribution, 
and then updates if you tell it to do so. 

Dunning letters procedures 

Creating dunning letters 
1 Click Accounts Payable>Dunning Letters>Dunning Letter Text F/M (ARF410). 

2 Specify the dunning letter number (1-5). The maximum number depends on how many 
dunning letters you set up in Dunning Letter F/M during installation and implementation.  

3 Specify each line of text that should appear on the dunning letter specified.  

4 Click Save.  

5 Click Exit.  

Printing a Dunning Letter Edit List 
1 Click Accounts Payable>Dunning Letters>Dunning Letter Edit List (ARR410).  

2 Specify the print Order: Customer, Alpha, Salesperson/Territory or Zip Code. 

3 Specify the beginning order choice to print. For example, if K was selected in the previous field, 
select the beginning customer class to print. Press F1 to default to FIRST.  . 

4 Specify the ending order choice to print. For example, if K was selected in the first field, select 
the ending customer class to print. Press F1 to default to LAST. 

5 (Optional) If you are printing in Zip Code order, specify the Country code.  

6 Specify the date that will print on the dunning letters. Press F1 to default to the system date.  

7 Click Reset to indicate the last dunning letter sent should be reset to 0 in the customer file if you 
are not printing a letter for this customer at this time. In other words, if customer is not selected 
for a dunning letter, should the system set the letter to 0 indicating their balance has been paid? 
Press Enter to default to unselected—not reset. 

8 Click OK to print the list. 

Printing dunning letters 
1 Click Accounts Payable>Dunning Letters>Dunning Letter Print (ARP410). 
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2 Specify the order in which to output the letters. The available options are Customer, Alpha, 
Salesperson/territory, K-customer class or Zip code order. Press Enter to default to C-
Customer.  

3 Specify the beginning order choice to print. For example, if K was selected in the previous field, 
select the beginning customer class to print. Press F1 to default to FIRST. 

4 Specify the ending order choice to print. For example, if K was selected the first field, select the 
ending customer class to print. Press F1 to default to LAST. 

5 Specify the date to print on the dunning letters. Press F1 to default to the system date. 

6 Check letters. OK to update customer file? After the letters print, verify that they output correctly. 
Click OK to proceed with the update (the system updates the customer file with the last dunning 
letter sent).  

Inquiries procedures 

Viewing customer information 
1 Click Accounts Receivable>Inquiries>Customer Inquiry. 

2 Specify the customer for which you want to view information. 

Optionally, click Change Filters if you want to limit the records that display by warehouse, item 
type, ship-to or customer return.  
Optionally, click Search. You can use the Starts With field to specify the beginning characters 
for the customer code. In the Start From field in the lower portion of the screen, you can select 
to display documents by document number or reference number.  

3 Click a view from the View menu option or the view bar. 
 

Quotes Displays quote information including quote number, quote date, 
expiration date, warehouse, sales order number (if converted to a 
sale), the customer for whom the quote was made, who gave the 
quote and the quote total.  
Getting more information on a quote: 

In the view area, select the line and click Line Detail or double click 
on the icon at the beginning of that line. 
  

Sales  
Orders 

Displays sales order information including document number, 
document type (work order, invoice, credit memo, counter sale, 
etc.), document status (work order entered but not printed, work 
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order printed, confirmed invoice, receipted invoice, deleted sales 
order, voided invoice), document origin, invoice date, warehouse, 
amount, ship-to and reference number.  

Sorting open sales orders: 
Orders sort by document number by default. Click on the 
Reference number column header to sort by reference number. 
Click on the Document number column header to sort by document 
number. You can also click on any other column header to sort by 
that information. 
  

If the document is on hold, *HOLD* appears in the column after the 
reference number. Documents on hold cannot be printed or 
confirmed. Any non-deleted or non-voided document may be 
selected for detail inquiry. 
Getting more information on an order: 

In the view area, select the line and click Line Detail or double click 
on the icon at the beginning of that line. On the Line Detail screen 
for Past Invoices view of SO Document Inquiry, the AR Detail 
button is available to view the AR document associated with the 
invoice if it is still on file.  

  

Past 
Invoices 

Displays past invoices including SO document number, AR invoice 
number, document type (work order, invoice, credit memo, counter 
sale, etc.), document origin, invoice date, warehouse, amount, 
ship-to and reference number.  

Sorting past invoices: 
Click on the Invoice column header to sort by past invoice number 
or click on the Reference number column header to sort by 
reference number. You can also click on any of the other column 
headers to sort by that information. 

  
Getting more information on a past invoice: 

In the view area, select the line and choose the Line Detail button 
or double click on the icon at the beginning of that line. In the Line 
Detail Past Invoices view of Customer Inquiry, there are 2 special 
buttons available above the line item browser. The GL Posting 
button is enabled when the transaction highlighted in the browser 
is one that allows for drill back from the source document to the GL 
posting that was created by the register. If the GL posting records 
can be found, then Journal Inquiry will display defaulting to 
showing transactions for this document only. The AR Detail button 
is available to view the AR document associated with the invoice if 
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it is still on file. 
  

Past Sales Displays past sales information for each item number and 
description. Listed information consists of invoice number and 
date, document origin, quantity sold and the corresponding unit of 
measure, price and the pricing unit of measure.  

Filtering past sales information by item type: 

Click Options>Filter Views from the menu bar.  
  

Pricing Displays customer pricing information on items. Listed information 
consists of item number, item description, the customer’s default 
price, pricing unit of measure and item type.  
Highlight a line and click:  
Orders to display the on order information for existing purchase 
orders, warehouse transfers or manufacturing tickets for the 
selected customer and item. Specify the display code: S-sales 
orders, T-warehouse transfers, M-manufacturing tickets. The 
display for each document includes: order number, type, status, 
ordered quantity, received quantity, back-ordered quantity, unit of 
measure for the quantities, cost and its corresponding unit of 
measure, the promised date and vendor number for all 
warehouses. 
Whse Qtys to display the warehouse quantity information. For the 
specified item, you can view the available, on-hand, and on-order 
quantities as well as long- and sort-term surplus and average lead 
time, in each warehouse. 
Line Detail to access level pricing, contracts, and past sales 
information for the customer/item combination.  

The Level Prices detail window shows the item’s standard pricing 
for the customer selected, as well as any price levels or quantity 
breaks that exist for this customer. 
The Contracts detail window shows the Contract Entry (SOE560) 
screen in view-only mode. The Past Sales detail window shows 
past sales information for the customer/item combination.  

Ship-to 
Addresses 

Displays alternate ship-to information from the created in the Ship-
To F/M for this customer. This view lists the alternate ship-to 
numbers, location names, contact 1, and phone number 1.  

Getting more information on alternate ship-to addresses: 
In the view area, select the line and click Line Detail or double click 
on the icon at the beginning of that line. The detail window displays 
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the alternate location’s mailing address, both phone numbers and 
contact names if provided, salesperson/territory, default ship via 
code, UPS zone, route code if routes are used in your system, tax 
code and tax rate as well as any user defined fields entered on the 
User Defined tab of Ship-To F/M (ARF920). 

  
Press Enter to view detail on the next alternate ship-to for the 
customer selected. Press F4 to backup to the main inquiry screen.  

Customer 
Returns 

Displays information on the returns documents for the selected 
customer. 
Filtering Customer Returns: 

Use the Change Filters button to select: All Returns, Open 
Returns, Completed Returns, Returns Waiting on Vendor Action, or 
Returns Waiting on the Goods for the display. You can also narrow 
the display by warehouse, item type and ship-to location. 

Blanket 
Sales 
Orders 

Displays information on blanket sales orders including document 
number, hold status, warehouse, entry date, expiration date, 
completion date, ship-to number and reference number.  

Sorting blanket sales orders: 
Orders sort by document number by default. Click on the 
Reference number column header to resort by reference number. 
Click on the Document number column header to resort by 
document number. You can also click on any other column header 
to sort by that information. 
If the document is on hold, *HOLD* appears to the right of the 
reference number. Documents on hold cannot be released or 
distributed.  
Getting more information on blanket sales orders: 

In the view area, select the line and click Line Detail or double click 
on the icon at the beginning of that line. 
  

MSDS Displays information on Material Safety Data Sheets (MSDS) that 
were sent to this customer. The information in the view consists of 
the MSDS ID and ID description, ship-to, date last sent, MSDS 
revision date and the invoice numbers with which the MSDS 
sheets were sent. 
Filtering MSDS information by ship-to addresses: 

Click Options>Filter Views from the menu. 
Press F2 to search existing ship-to addresses. Press F3 to select 
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all ship-to addresses for this customer. 

Customer 
Notes 

Displays customer notes information. 

Lost Sales Displays lost sales information for each item for the specified 
customer. Listed information consists of item number and 
description, Ship-to locations, salesperson information, order entry 
date and user, and edit date and user. 

Proposals  Displays service proposals entered in the Service & Repair 
module for the specified customer. Information in the browser 
includes the proposal number, effective and expiration dates, 
contact, total amount and reference information. The Line Detail 
button displays the Service Proposal Inquiry with details for the 
highlighted line item. 

Contracts Displays service contracts entered in the Service and Repair 
module for the specified customer. Information in the browser 
includes the contract number, effective and expiration dates, 
contact, total amount and reference information. The Line Detail 
button displays the Service Contract Inquiry with details for the 
highlighted line item. 

Doc Routing  Displays routing information for documents entered in the Service 
and Repair module for the specified customer. Information in the 
browser includes the account number, document type, doc 
description, routes, fax number, and email address. 

  
User-
Defined  

The data that appears on the User-Defined view of Customer 
Inquiry comes from the User-Defined view of Customer F/M 
(ARF910). Many users have a few pieces of information about 
customers, vendors, and items that are unique to their business 
that they would like to enter into FACTS for reference purposes. 
The User-Defined view displays user-defined fields entered the 
major file maintenances and makes them available in FACTS 
Inquiry programs for information only. There are 5 user-defined 
fields that can be entered on the User-Defined screen of Customer 
F/M). There user-defined field must first be configured by a user 
that has administrator privileges for User-defined Fields setting on 
the Security tab of User Code F/M (SMF410).  
  

Credit Displays tabs for Aging, Payment history and Sales history. • 
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History Payment history includes last payment date and grace period. 
Information also includes both invoices and weighted dollars. 
Invoice Payment Statistics include the total number of invoices 
paid, the average number of days to pay, the dollars paid, and the 
weighted average days to pay are also displayed in accumulated 
periods. The accumulation of data into periods displays the “Last 
03 Periods” , the “Last 06 Periods” and “Last 12 Periods” as the 
accumulation of data from the current period through the specified 
periods back from the current period. • Sales history includes the 
account opening date, last sale date, highest balance date and 
highest balance. Information also includes sales, cost and gross 
margin percentage for month-to-date, year-to-date, and prior year. 
• Aging displays credit history in three categories: the Current date 
for balances due, Total aging and Disputed.  

Check 
History 

Displays accounts receivable document information by check 
number. The number of periods check history is kept is dependent 
on the Check History setting on in AR Static F/M. The Check 
History view displays check numbers for the highlighted customer 
along with the check date, check amount, and check memo.  

Ledgercards  Displays all ledgercard information for the selected customer from 
newest to oldest by default. Information displayed includes entry 
date, debit amount, credit amount, balance, transaction (register) 
type, document number and register number of each ledgercard on 
file for this customer. Click View Doc at the bottom of the screen to 
display additional document detail information. The system checks 
to see if detail info exists for currently highlighted ledgercard line 
for its transaction type.  

Open docs Displays the open documents for the customer including the 
document number, type, ship-to number, register number, entry 
period, date entered, due date, the original amount and the current 
amount. If the open document was created from SO, the SO 
document number that the open document applies to is also 
displayed.  

Paid Doc 
History   

Displays document number, reference number, ship-to number, 
original amount, original discount amount, entry period, entry 
register number and removal register number. The documents 
initially appear in document number order.  

4 Click Exit. 
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Reports and prints procedures 

Setting up an Aged Trial Balance report 
1 Click Accounts Payable>Reports>Aged Trial Balance. 

2 Specify the order in which to print the report. The options are Customer, Alpha, 
Salesperson/Territory and Customer Class (K). 

3 Specify the Over Credit Limit Only check box to run the report for customers that are over their 
credit limit only. 

4 Specify the beginning order choice to print. For instance, if you set the report to print in 
Customer order, select the first customer that should appear. Press F1 to default to FIRST. 
Press F2 to search of customers, salespeople and classes. 

5 Specify the ending order choice to print. For instance, if you set the report to print in Customer 
order, select the last customer that should appear. Press F1 to default to LAST. Press F2 to 
search of customers, salespeople and classes. 

6 Specify which branches to include. The entry must be a valid in the system. The program 
defaults to the branch assigned to the terminal. Press F1 to default to ALL. Press F2 to search. 

7 Specify the date upon which aging will be based. Press F1 to default to the system date. 

8 Indicate whether or not to include Next Period documents and transactions. The program 
defaults to selected. 

9 Indicate whether or not to include Delinquents Only on the report. The program defaults to 
unselected. 

10 (Optional) If you selected the Delinquents Only check box, specify the number of days a 
document must be past due in order for it to appear on this report (0-999). The program defaults 
to 10. 

11 Indicate whether to include Credits on the report. The program defaults to selected. 

12 Select the Disputed Only check box to run the report for disputed invoices only. 

13 Indicate whether to check if the customer is over their credit limit by selecting the Credit Limit 
Check check box, or leave unselected to skip the credit limit check. 

14 Specify whether to include Contact information and/or Sales figures. The program defaults to 
NONE. 

15 Specify the document’s scope. Options are Summary, Detail or detail with Transaction 
information. Press Enter to default to S. 

16 Click OK. 
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Printing a Customer Ledgercard report 
1 Click Accounts Payable>Reports>Customer Ledgercards. 

2 Specify the order in which to print the report information. Options are Customer, Alpha, 
Salesperson/territory and Customer Class (K). The program defaults to C. 

3 Select the beginning order choice to print. For instance, if you set the report to print in Alpha 
order, select the first alpha that should appear. Press F1 to default to FIRST. Press F2 or to 
search of customers, salespeople and classes. 

4 Select the ending order choice to print. For instance, if you set the report to print in Alpha order, 
select the last alpha that should appear. Press F1 default to LAST. Press F2 to search of 
customers, salespeople and classes. 

5 Specify the branch or branches that you want to include. The branch or branches you enter 
must be valid in the system. The program defaults to the branch assigned to the terminal. Press 
F1 to default to ALL. Press F2 to search. 

6 Select the date order, that is Newest date to oldest date or Oldest date to newest date. The 
program defaults to unselected. 

7 Specify the beginning ledgercard date to print. Press F1 to default to FIRST. 

8 Specify the ending ledgercard date to print. Press F1 to default to LAST. 

9 Specify each of the transaction or register types that should appear on the report. The options 
are Beginning balance, Cash Receipts & Adjustments Register, AR Sales Register, SO 
Daily Sales Register (also includes ER Daily Rental Register), TS Invoice Register, Service 
Charge Register, Returned Check Register or X-Customer Balancing Register transaction 
types. Press F1 to default to ALL. 

10 Click OK to run the report. 

Printing a Customer Ship-to Report 
1 Click Accounts Payable>Reports>Customer Ship-to Report. 

2 Specify the order in which to print the report information. Options are Customer, Alpha, 
Salesperson/territory and Customer Class (K). The program defaults to C. 

3 Select the beginning order choice to print. For instance, if you set the report to print in 
Customer order, select the first customer that should appear. Press F1 to default to FIRST. 
Press F2 to search of customers, salespeople and classes. 

4 Select the ending order choice to print. For instance, if you set the report to print in Customer 
order, select the last customer that should appear. Press F1 to default to LAST. Press F2 to 
search of customers, salespeople and classes. 

5 Specify the branch or branches that you want to include. The branch or branches you enter 
must be valid in the system. The program defaults to the branch assigned to the terminal. Press 
F1 to default to ALL. Press F2 to search of customers, salespeople and classes. 
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6 Select which type of information to print on the report: Address, Phone and/or Contact 
information. Press F1 to default to NONE. 

7 Indicate whether you want to include temporary ship-to addresses. The program defaults to 
unselected. 

8 Specify the number of lines to skip between ship-to addresses on the report (0-9). The 
program defaults to 0. 

9 Click OK to run the report. 

Printing Customer Notes 
1 Click Accounts Payable>Reports>Customer Listing. 

2 Enter the order in which to print the report information. Options are Customer, Alpha, 
Salesperson/territory and Customer Class (K). The program defaults to C. 

3 Select the beginning order choice to print. For instance, if you set the report to print in 
Customer order, select the first customer that should appear. Press F1 to default to FIRST. 
Press F2 to search of customers, salespeople and classes. 

4 Select the ending order choice to print. For instance, if you set the report to print in Customer 
order, select the last customer that should appear. Press F1 to default to LAST. Press F2 to 
search of customers, salespeople and classes. 

5 Enter the branch or branches that you want to include. The branch or branches you enter must 
be valid in the system. The program defaults to the branch assigned to the terminal. F3 defaults 
to ALL. Press F2 to search. 

6 Indicate whether you want the program to start a new page for each customer listed. The 
program defaults to unselected. 

7 Click OK. 

End of period procedures 
The end-of-period procedures should be run at the end of each Accounts Receivable period to close 
it correctly.  
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End of period checklist: Accounts Receivable 
Period ____ Year _____ 

User Date Menu   Description 

_________ _________ Invoices 1. Complete all invoicing  

_________ _________ Cash Rec. 2. Post all cash & print/update last Cash 
Receipts & Adjustments Register  

_________ _________ EOP 3. Print/update Service Charge Register  

_________ _________ Reports 4. Print Open Receivables Report (detail 
w/transactions) 

_________ _________ Reports 5. Print Aged Trial Balance (detail 
w/transactions) 

_________ _________ Reports 6. Run Customer Ledgercard print 

_________ _________ EOP 7. Print Statements  

_________ _________ EOP 8. Print/update Sales Tax Register  

_________ _________ EOP 9. Print/update Register History Report  

_________ _________ EOP 10. Print/update Document Removal 
Register  

_________ _________ EOP 11. Run System Clean Up F/M (SMF993)   

_________ _________ EOP 12. Run End-of-Period Update  

 

 End of period checklist explanation 

1 Complete all Invoicing. If SO invoicing is used, print all invoices for the current period, 
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release any unfinished routes (if used) and run/update SO Daily Sales Register. If AR 
invoicing is used, print all invoices (if used) and run/update AR Sales Register. All invoicing 
should be complete to ensure the AR balance is up to date when the period procedures 
begin. 

2 Post all Cash and Run Cash Receipts & Adjustments Register.  These steps must be 
complete to keep accurate payment history for each customer. If a current Cash Receipts 
& Adjustments Register is run after the period close, the payments are posted to the next 
period and the statements and service charges may be inaccurate.  

3 Print/update Service Charge Register. If you charge a service charge, this program prints a 
report of all service charges. After the report prints, it should be updated to post the service 
charges to customer accounts. All Service Charge Registers should be kept as an audit 
trail.  

4-5 Print Open Receivables Report and Aged Trial Balance (detail w/transactions). These 
reports provide a list of all transactions that have taken place against all documents 
including zero balance documents (paid down to zero). These documents and transactions 
will be removed by the Document Removal Register (#10). It is recommended that a hard 
copy of each report be saved for future reference. 

6 Run Customer Ledgercard print. If customer ledgercards are used, this program provides a 
list of all transactions that have occurred on customer accounts. These transactions will be 
removed by the System Clean Up F/M (SMF993) program. It is recommended that a hard 
copy be saved for future reference.  

7 Print statements.  If you send statements, this program may be run when needed.  The 
statement print does not update any data or alter customer balances. The Statement Print 
lists open receivables by customer. 

8 Print Sales Tax Register. This report provides a listing of sales tax, which has accumulated 
through the SO Daily Sales Register and/or AR Sales Register in the current period. After 
the Sales Tax Register prints, you should remove the records just printed to clear the file. If 
records are not removed they will appear on next period's register. All Sales Tax Registers 
should be kept as an audit trail. 

9 Print Register History Report. This report lists all registers: AR Sales, SO Daily Sales, 
Customer Balancing, Service Charge, Cash Receipts and Returned Check, which were run 
during the period and updated the AR balance. This report provides a trace of what 
transactions occurred to obtain the current AR balance. After the report prints, you should 
remove the records just printed to clear the file. If records are not removed, they will 
appear on next period's register. All Register History Reports should be kept as an audit 
trail. 
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10 Print Document Removal Register. This register lists documents that have been paid down 
to zero in the current period. After the register prints, you should remove the records just 
printed to clear the file. If records are not removed, they will appear on next period’s 
register. During the removal of the records, the program also updates customer payment 
history and may update the paid documents history and paid document transaction history 
files (if paid document history is stored). All Document Removal Registers should be kept 
as an audit trail.  

11 Run System Clean Up F/M (SMF993).  If customer ledgercards are used, this program is 
run to remove ledgercard information. You determine the cutoff date through which the 
system removes ledgercard information.  

12 Run End-of-Period Update.  This is the last step to closing the Accounts Receivable 
current period and should only be run after all of the above procedures are complete. The 
program sets period-to-date sales and cost figures in the customer and salesperson files to 
zero and closes the current period. If it is the last period of the year, year-to-date figures in 
these files are rolled into prior year. When this program is complete, you may begin daily 
procedures in Accounts Receivable in the new (current) period. 

Running the Customer Balancing Register 
1 Click Accounts Payable>Reports>Customer Balancing Register. 

2 Indicate whether you want to print the register. Press Enter to default to selected. 

3 When the Customer Balancing Register finishes running, you have the option of updating the 
customer files to balance with the open documents file. 

4 Indicate whether you want the program to update customer balances. Press Enter to default to 
unselected. 

5 Click OK. 

Running the Sales Tax Register 
1 Click Accounts Receivable>End of Period>Sales Tax Register. 

2 Specify the beginning tax code to print.  

3 Specify the ending tax code to print.   

4 Specify the beginning sales tax date to print. This is the first date of invoicing after the old tax 
records were removed from the system.  

5 Specify the ending sales tax date to print.  

6 Specify the branch number to print.  
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7 Specify the scope. Indicate whether you want to the register to print S-summary or D-detail 
information. The program defaults to S. 

8 Click OK. 

9 Check register. OK to remove records just printed? displays. Click OK. 

Running the Service Charge Register 
1 Click Accounts Receivable>End of Period>Service Charge Register. 

2 Specify the service charge date. Valid dates are between the specified minimum and maximum 
number of days after the last register was updated and must be in the current or next GL period 
and not prior to the current AR period. Select F1 to default to the system date. If you need to 
know the date on which the Service Charge Register was last run, refer to Service Charge 
Control F/M. 

3 Specify the scope of the report: Summary or Detail. The program defaults to S. 

4 At the Negative field, indicate whether or not you want to include negative documents when 
calculating service charges. 

5 Click OK. 

6 The system builds the GL distribution while it prints the Service Charge Register. The 
parameters established in the AR Sales to GL Posting F/M program and AR GL posting tables 
affect how the system builds the distribution. 

Service Charge Register. OK to print GL distribution? displays. After printing the Service Charge 
Register, verify the printout. If you need to make a correction, click Cancel to exit the program. 
You can rerun the register after you make the correction. If everything is correct, click OK to 
continue. The program prints the GL distribution. Verify the accuracy of the GL distribution, and 
when you are ready, proceed with the update. 
 
OR 

If you are not printing the GL distribution, the system displays this message: Check register. OK 
to update? 

After printing the Service Charge Register, verify the printout. If there is a correction to be made, 
click Cancel to exit the program. After the correction is made, the register can be rerun. If 
everything is correct, click OK to continue. The program will not print a GL distribution; it skips 
the following field and proceeds with the update. 

7 Check GL distribution. OK to update? After printing the distribution, verify the printout. If 
everything is correct, click OK to continue. The program proceeds with the update. If there is a 
correction to be made, click Cancel to exit the program. After the correction is made, the entire 
register process begins again. The program runs the register first, then prints the GL distribution, 
and then updates if you tell it to do so. 
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Running the Document Removal Register 
1 Click Accounts Receivable>End of Period>Document Removal Register. 

2 Specify the branch number.  

3 Check the Print Disputed Invoices check box to print and optionally remove zero balance 
disputed invoices. 

4 Click OK.  

5 Check register. OK to update? Check the register print out and click OK or Cancel to indicate 
whether to update the payment history file and remove the zero balance records the register just 
printed. 

Running the End-of-Period Update 
1 Click Accounts Receivable>End of Period>End-Of-Period Update. 

2 Closeout period? Verify that you want to close the current Accounts Receivable period by 
selecting this field.  

3 Have the above End-of-Period programs been run? This field is a last check to verify that ran all 
the necessary reports before closing this period. Check Yes. This field defaults to N and the 
program terminates if you click OK.  

4 (Optional) If you closed the last AR period less than 20 days before the system date, the 
program displays a message indicating the number of days since the last close and the next field 
appears.  
Are you sure you want to close out this period? Check the box to re-verify that you are ready to 
close this period.  

5 If you do not wish to close the period, click Cancel in the lower right corner of the screen. (If the 
last AR period was closed more than 20 days before the system date, this field does not appear.) 

6 Click OK. 
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